WARRANTY
The Anritsu product(s) listed on the title page is (are) warranted against defects in materials and workmanship for one year from the date of shipment. Anritsu's obligation covers repairing or replacing products which prove to be defective during the warranty period. Buyers shall prepay transportation charges for equipment returned to Anritsu for warranty repairs. Obligation is limited to the original purchaser. Anritsu is not liable for consequential damages.

LIMITATION OF WARRANTY
The foregoing warranty does not apply to Anritsu connectors that have failed due to normal wear. Also, the warranty does not apply to defects resulting from improper or inadequate maintenance by the Buyer, unauthorized modification or misuse, or operation outside the environmental specifications of the product. No other warranty is expressed or implied, and the remedies provided herein are the Buyer's sole and exclusive remedies.

TRADEMARK ACKNOWLEDGMENTS
Anritsu, FlexCal, InstaCal and Site Master are trademarks of Anritsu Company.

NOTICE
Anritsu Company has prepared this manual for use by Anritsu Company personnel and customers as a guide for the proper installation, operation and maintenance of Anritsu Company equipment and computer programs. The drawings, specifications, and information contained herein are the property of Anritsu Company, and any unauthorized use or disclosure of these drawings, specifications, and information is prohibited; they shall not be reproduced, copied, or used in whole or in part as the basis for manufacture or sale of the equipment or software programs without the prior written consent of Anritsu Company.

UPDATES
Updates to this manual, if any, may be downloaded from the Anritsu Internet site at: http://www.us.anritsu.com

Anritsu contact information can be accessed from the following Internet site: http://www.anritsu.com/Contact.asp
DECLARATION OF CONFORMITY

Manufacturer’s Name:  ANRITSU COMPANY

Manufacturer’s Address: Microwave Measurements Division
490 Jarvis Drive
Morgan Hill, CA 95037-2809
USA

declares that the product specified below:

Product Name:  Site Master

Model Number:  S331D, MS2711D

conforms to the requirement of:


Electromagnetic Interference:

Emissions:  
CISPR 11:1990/EN55011: 1991 Group 1 Class A
EN 61000-3-2:1995 Class A
EN 61000-3-3:1995 Class A

Immunity: 
EN 61000-4-2:1995/EN50082-1: 1997 - 4kV CD, 8kV AD
EN 61000-4-3:1997/EN50082-1: 1997 - 3V/m
EN 50204/EN50082-1: 1997 – 3V/m
EN 61000-4-4:1995/EN50082-1: 1997 - 0.5kV SL, 1kV PL
EN 61000-4-5:1995/EN50082-1: 1997 - 1kV L-L, 2kV L-E
EN 61000-4-8:1994/EN61326: 1998 – 3A/m
EN 61000-4-11:1994/EN61326: 1998 – 1 cycle@100%

Electrical Safety Requirement:

Product Safety:  The Product Complies when used with Company supplied Power
Supply (tested to EN 60950)

[Signature]

Corporate Quality Director

Morgan Hill, CA

12-04-03

Date

European Contact: For Anritsu product EMC & LVD information, contact Anritsu LTD, Rutherford Close,
Stevenage Herts, SG1 2EF UK, (FAX 44-1438-740202)
产品中有毒有害物质或元素的名称及含量

<table>
<thead>
<tr>
<th>部件名称</th>
<th>有毒有害物质或元素</th>
<th>铅 (Pb)</th>
<th>汞 (Hg)</th>
<th>镉 (Cd)</th>
<th>六价铬 (Cr(VI))</th>
<th>多溴联苯 (PBBr)</th>
<th>多溴联苯醚 (PBDE)</th>
</tr>
</thead>
<tbody>
<tr>
<td>印刷电路板 (PCA)</td>
<td>×</td>
<td>○</td>
<td>×</td>
<td>×</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>机壳、支架 (Chassis)</td>
<td>×</td>
<td>○</td>
<td>×</td>
<td>×</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>其他 (电线、风扇、连接器等) (Appended goods)</td>
<td>×</td>
<td>○</td>
<td>×</td>
<td>×</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
</tbody>
</table>

〇：表示该有毒有害物质或元素在该部件所有的均质材料中的含量均在 SJ/T11363-2006 标准规定的限量要求以下。
×：表示该有毒有害物质至少在该部件的某一均质材料中的含量超过 SJ/T11363-2006 标准规定的限量要求。

环保使用期限

这个标志是根据 2006/2/28 公布的「电子信息产品污染控制管理办法」以及 SJ/T 11364-2006「电子信息产品污染控制标识要求」的规定，适用于在中国销售的电子信息产品的环保使用期限。仅基于在遵守该产品的安全使用及使用注意事项的基础上，从生产日起算的该年限内，不会因产品所含有害物质的稀释或转化等变异，而对环境污染、人体及财产产生深刻的影响。

注：电池的环保使用期限是 5 年，生产日期标注在产品序号的前四位（如 S/N 07080000，07 年第 08 周生产）。


For Products placed on the EU market after August 13, 2005, please contact your local Anritsu representative at the end of the product’s useful life to arrange disposal in accordance with your initial contract and the local law.
# Table of Contents

## Chapter 1
### General Information
- Introduction .................................. 1-1
- Description ................................... 1-1
- Standard Accessories ............................. 1-2
- Options ..................................... 1-2
- External Detectors ............................... 1-3
- Optional Accessories.............................. 1-4
- Performance Specifications ......................... 1-7
- Preventive Maintenance ........................... 1-10
- Calibration .................................. 1-10
  - InstaCal Module ................................ 1-11
- Annual Verification.............................. 1-11
- ESD Precautions ................................ 1-11
- Anritsu Service Centers............................ 1-11
- Mode References . ................................ 1-11

## Chapter 2
### Functions and Operations
- Introduction .................................. 2-1
- Test Connector Panel ............................. 2-1
- Display Overview ............................... 2-3
- Front Panel Overview ............................. 2-4
- Function Hard Keys ................................ 2-5
- Keypad Hard Keys ................................ 2-6
- Soft Keys.................................... 2-8
- Power Monitor, External Detector (Option 5) ................ 2-16
- Symbols.................................... 2-17
- Self Test ................................... 2-18
- Error Messages ................................. 2-19
- Battery Information. ............................... 2-23
- Charging a New Battery ........................... 2-23
- Determining Remaining Battery Life. ................ 2-24
- Important Battery Information .................... 2-26
Chapter 7
Handheld Software Tools

Introduction .................................. 7-1
Features .................................... 7-1
System Requirements ............................. 7-2
Installation ................................... 7-2
Using Handheld Software Tools .................. 7-5
  Downloading Traces ............................. 7-5
  Plot Capture to the PC ............................ 7-5
  Plot Upload to the Instrument .................... 7-5
  Plot Properties ................................ 7-6
Signal Standards Editor ........................ 7-11

Chapter 8
Master Software Tools

Introduction .................................. 8-1
Key Features of Master Software Tools ........ 8-1
Minimum System Requirements ................ 8-4

Appendix A
Windowing

Introduction .................................. A-1
Examples ...................................... A-1
Chapter 1
General Information

Introduction

This chapter provides a description, performance specifications, optional accessories, preventive maintenance, and calibration requirements for the Site Master™ model S331D. Throughout this manual, the term Site Master will refer to the S331D.

<table>
<thead>
<tr>
<th>Model</th>
<th>Frequency Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>S331D</td>
<td>Cable and Antenna Analyzer Mode: 25 to 4000 MHz</td>
</tr>
</tbody>
</table>

Description

The Site Master is a handheld cable and antenna analyzer designed for installers, contractors, and wireless service providers who need a portable and rugged cable and antenna analyzer.

It is designed for measuring Return Loss, VSWR, Cable Loss, of cable and antenna systems from 25 MHz to 4 GHz. Integrated Distance-To-Fault measurement can be used to locate the precise location of a fault within the feedline system. Options available with the S331D include High Accuracy Power Meter (Option 19) and Power Monitor (Option 5).

The Site Master is capable of up to 1.5 hours of continuous operation from a fully charged field-replaceable battery and can be operated from a 12.5 Vdc source. Built-in energy conservation features can be used to extend the battery life.

A standard 640*480 color TFT display provide graphic indications of various measurements. The displayed trace can be scaled or enhanced with frequency markers and limit lines. A menu option provides for an audible "beep" when the limit value is exceeded.
Standard Accessories

The Handheld Software Tools and Master Software Tools PC-based software programs provide a database record for storing measurement data. Software Tools can also convert the Site Master display to a Microsoft Windows workstation graphic. Measurements stored in the Site Master internal memory can be downloaded to the PC using the included null-modem serial cable. Once stored, the graphic trace can be displayed, scaled, or enhanced with markers and limit lines. Historical graphs can be overlaid with current data, and underlying data can be extracted and used in spreadsheets or for other analytical tasks.

The Handheld Software Tools program can display measurements made with the Site Master (SWR, return loss, cable loss, distance-to-fault) as well as providing other functions, such as converting display modes and Smith charts. Refer to Chapter 7, Handheld Software Tools, for more information.

The following items are supplied with the basic hardware:

- 65717 Soft Carrying Case
- 633-27 Rechargeable Battery, Ni-MH
- 40-168-R AC–DC Adapter
- 806-141 Automotive Cigarette Lighter 12 Volt DC Adapter
- 2300-347 Handheld Software Tools CDROM
- 800-441 Serial Interface Cable (null modem type)
- 551-1691-R USB to RS-232 Adapter Cable
- 10580-00079 S331D Site Master User’s Guide
- One-Year Warranty

Options

- Option 5 Power Monitor - Requires external detector
- Option 19 High Accuracy Power Meter (sensor not included)
External Detectors

The following Anritsu detectors can be used with the Site Master S331D when equipped with Option 5, Power Monitor.

<table>
<thead>
<tr>
<th>Model</th>
<th>Frequency Range</th>
<th>Impedance</th>
<th>Return Loss</th>
<th>Input Conn.</th>
<th>Frequency Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>5400-71N50</td>
<td>0.001 to 3 GHz</td>
<td>50Ω</td>
<td>26 dB</td>
<td>N(m)</td>
<td>±0.2 dB, &lt;1 GHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+0.3 dB, &lt;3 GHz</td>
</tr>
<tr>
<td>5400-71N75</td>
<td>0.001 to 3 GHz</td>
<td>75Ω</td>
<td>26 dB, &lt;2 GHz</td>
<td>N(m)</td>
<td>±0.2 dB, &lt;1 GHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>20 dB, &lt;3 GHz</td>
<td></td>
<td>+0.5 dB, &lt;3 GHz</td>
</tr>
<tr>
<td>560-7N50B</td>
<td>0.01 to 20 GHz</td>
<td>50Ω</td>
<td>15 dB, &lt;0.04 GHz</td>
<td>N(m)</td>
<td>±0.5 dB, &lt;18 GHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>22 dB, &lt;8.00 GHz</td>
<td></td>
<td>+1.25 dB, &lt;20 GHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>17 dB, &lt;18.0 GHz</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>14 dB, &lt;20.0 GHz</td>
<td></td>
<td></td>
</tr>
<tr>
<td>560-7S50B</td>
<td>0.01 to 20 GHz</td>
<td>50Ω</td>
<td>15 dB, &lt;0.04 GHz</td>
<td>WSMA</td>
<td>±0.5 dB, &lt;18 GHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>22 dB, &lt;8.00 GHz</td>
<td>(m)</td>
<td>+2.0 dB, &lt;20 GHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>17 dB, &lt;18.0 GHz</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>14 dB, &lt;20.0 GHz</td>
<td></td>
<td></td>
</tr>
<tr>
<td>560-7K50</td>
<td>0.01 to 40 GHz</td>
<td>50Ω</td>
<td>12 dB, &lt;0.04 GHz</td>
<td>K(m)</td>
<td>±0.5 dB, &lt;18 GHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>22 dB, &lt;8.00 GHz</td>
<td></td>
<td>+1.25 dB, &lt;26.5 GHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>17 dB, &lt;18.0 GHz</td>
<td></td>
<td>+2.2 dB, &lt;32 GHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>15 dB, &lt;26.5 GHz</td>
<td></td>
<td>+2.5 dB, &lt;40 GHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>14 dB, &lt;32.0 GHz</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>13 dB, &lt;40.0 GHz</td>
<td></td>
<td></td>
</tr>
<tr>
<td>560-7VA50</td>
<td>0.01 to 50 GHz</td>
<td>50Ω</td>
<td>12 dB, &lt;0.04 GHz</td>
<td>V(m)</td>
<td>±0.8 dB, &lt;20 GHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>19 dB, &lt;20.0 GHz</td>
<td></td>
<td>+2.5 dB, &lt;40 GHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>15 dB, &lt;40.0 GHz</td>
<td></td>
<td>+3.0 dB, &lt;50 GHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>10 dB, &lt;50.0 GHz</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Optional Accessories

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Calibration Components</strong></td>
<td></td>
</tr>
<tr>
<td>ICN50B</td>
<td>InstaCal™ Calibration Module, 2 MHz to 6.0 GHz, N(m), 50Ω</td>
</tr>
<tr>
<td>OSLN50-1</td>
<td>Precision Open/Short/Load, DC to 6 GHz, 42 dB, 50Ω, N(m)</td>
</tr>
<tr>
<td>OSLN50-1</td>
<td>Precision Open/Short/Load, DC to 6 GHz, 42 dB, 50Ω, N(f)</td>
</tr>
<tr>
<td>22N50</td>
<td>Open/Short, DC to 18 GHz, N(m), 50Ω</td>
</tr>
<tr>
<td>SM/PL-1</td>
<td>Precision Load, DC to 6 GHz, 42 dB, N(m), 50Ω</td>
</tr>
<tr>
<td>22NF50</td>
<td>Open/Short, DC to 18 GHz, N(f), 50Ω</td>
</tr>
<tr>
<td>SM/PLNF-1</td>
<td>Precision Load, DC to 6 GHz, 42 dB, N(f), 50Ω</td>
</tr>
<tr>
<td>2000-1618-R</td>
<td>Precision Open/Short/Load, DC to 6 GHz, 7/16 DIN(m), 50Ω</td>
</tr>
<tr>
<td>2000-1619-R</td>
<td>Precision Open/Short/Load, DC to 6 GHz, 7/16 DIN(f), 50Ω</td>
</tr>
<tr>
<td>22N75</td>
<td>Open/Short, DC to 3 GHz, N(m) 75Ω</td>
</tr>
<tr>
<td>26N75A</td>
<td>Precision Termination, DC to 3 GHz, N(m) 75Ω</td>
</tr>
<tr>
<td>22NF75</td>
<td>Open/Short, DC to 3 GHz, N(f) 75Ω</td>
</tr>
<tr>
<td>26NF75A</td>
<td>Precision Termination, DC to 3 GHz, N(f) 75Ω</td>
</tr>
<tr>
<td>12N50-75B</td>
<td>Matching Pad, DC to 3 GHz, 50 O to 75Ω</td>
</tr>
<tr>
<td><strong>Precision Adapters</strong></td>
<td></td>
</tr>
<tr>
<td>34NN50A</td>
<td>Precision Adapter, N(m)-N(m), DC to 18 GHz, 50Ω</td>
</tr>
<tr>
<td>34NFNF50</td>
<td>Precision Adapter, N(f)-N(f), DC to 18 GHz, 50Ω</td>
</tr>
<tr>
<td><strong>Adapters</strong></td>
<td></td>
</tr>
<tr>
<td>1091-26-R</td>
<td>Adapter, N(m)-SMA(m), DC to 18 GHz, 50Ω</td>
</tr>
<tr>
<td>1091-27-R</td>
<td>Adapter, N(m)-SMA(f), DC to 18 GHz, 50Ω</td>
</tr>
<tr>
<td>1091-80-R</td>
<td>Adapter, N(f)-SMA(m), DC to 18 GHz, 50Ω</td>
</tr>
<tr>
<td>1091-81-R</td>
<td>Adapter, N(f)-SMA(f), DC to 18 GHz, 50Ω</td>
</tr>
<tr>
<td>1091-172</td>
<td>Adapter, N(m)-BNC(f), DC to 1.3 GHz, 50Ω</td>
</tr>
<tr>
<td>510-90-R</td>
<td>Adapter, 7/16 DIN(f)-N(m), DC to 7.5 GHz, 50Ω</td>
</tr>
<tr>
<td>510-91-R</td>
<td>Adapter, 7/16 DIN(f)-N(f), DC to 7.5 GHz, 50Ω</td>
</tr>
<tr>
<td>510-92-R</td>
<td>Adapter, 7/16 DIN(m)-N(m), DC to 7.5 GHz, 50Ω</td>
</tr>
<tr>
<td>510-93-R</td>
<td>Adapter, 7/16 DIN(m)-N(f), DC to 7.5 GHz, 50Ω</td>
</tr>
<tr>
<td>510-96-R</td>
<td>Adapter, 7/16 DIN(m)-7/16 DIN(m), DC to 7.5 GHz, 50Ω</td>
</tr>
<tr>
<td>510-97-R</td>
<td>Adapter, 7/16 DIN(f)-7/16 DIN(f), DC to 7.5 GHz, 50Ω</td>
</tr>
<tr>
<td><strong>Adapters w/ Reinforced Grip</strong></td>
<td></td>
</tr>
<tr>
<td>1091-379-R</td>
<td>Adapter w/ Reinforced Grip, 7/16 DIN(f)-7/16 DIN(f), DC to 6 GHz, 50Ω</td>
</tr>
</tbody>
</table>
## Test Port Cables, Armored

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>15NN50-1.5C</td>
<td>Test Port Cable Armored, 1.5 meters, N(m)-N(m), 6 GHz, 50Ω</td>
<td></td>
</tr>
<tr>
<td>15NN50-3.0C</td>
<td>Test Port Cable Armored, 3.0 meters, N(m)-N(m), 6 GHz, 50Ω</td>
<td></td>
</tr>
<tr>
<td>15NNF50-1.5C</td>
<td>Test Port Cable Armored, 1.5 meters, N(m)-N(f), 6 GHz, 50Ω</td>
<td></td>
</tr>
<tr>
<td>15NNF50-3.0C</td>
<td>Test Port Cable Armored, 3.0 meters, N(m)-N(f), 6 GHz, 50Ω</td>
<td></td>
</tr>
</tbody>
</table>

## Test Port Cables, Armored w/ Reinforced Grip

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>15RNFN50-1.5-R</td>
<td>Test Port Cable Armored w/Reinforced Grip 1.5 meters, N(m)-N(f), 6 GHz, 50Ω</td>
<td></td>
</tr>
<tr>
<td>15RNFN50-3.0-R</td>
<td>Test Port Cable Armored w/Reinforced Grip 3.0 meters, N(m)-N(f), 6 GHz, 50Ω</td>
<td></td>
</tr>
<tr>
<td>15RDFN50-1.5-R</td>
<td>Test Port Cable Armored w/Reinforced Grip 1.5 meters, 7/16 DIN(f)-N(m), 6 GHz, 50Ω</td>
<td></td>
</tr>
<tr>
<td>15RDFN50-3.0-R</td>
<td>Test Port Cable Armored w/Reinforced Grip 3.0 meters, 7/16 DIN(f)-N(m), 6 GHz, 50Ω</td>
<td></td>
</tr>
<tr>
<td>15RDMN50-1.5-R</td>
<td>Test Port Cable Armored w/Reinforced Grip 1.5 meters, 7/16 DIN(m)-N(m), 6 GHz, 50Ω</td>
<td></td>
</tr>
<tr>
<td>15RDMN50-3.0-R</td>
<td>Test Port Cable Armored w/Reinforced Grip 3.0 meters, 7/16 DIN(m)-N(m), 6 GHz, 50Ω</td>
<td></td>
</tr>
</tbody>
</table>

## Attenuators

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>3-1010-119</td>
<td>Attenuator, 10 dB, 2W, DC to 6 GHz</td>
<td></td>
</tr>
<tr>
<td>3-1010-122</td>
<td>Attenuator, 20 dB, 5W, DC to 12.4 GHz, N(m)-N(f)</td>
<td></td>
</tr>
<tr>
<td>42N50-20</td>
<td>Attenuator, 20 dB, 5W, DC to 18 GHz, N(m)-N(f)</td>
<td></td>
</tr>
<tr>
<td>3-1010-123</td>
<td>Attenuator, 30 dB, 50W, DC to 8.5 GHz, N(m)-N(f)</td>
<td></td>
</tr>
<tr>
<td>42N50A-30</td>
<td>Attenuator, 30 dB, 50W, DC to 18 GHz, N(m)-N(f)</td>
<td></td>
</tr>
<tr>
<td>1010-127-R</td>
<td>Attenuator, 30 dB, 150W, DC to 3 GHz, N(m)-N(f)</td>
<td></td>
</tr>
<tr>
<td>3-1010-124</td>
<td>Attenuator, 40 dB, 100W, DC to 8.5 GHz, N(m)-N(f), Uni-directional</td>
<td></td>
</tr>
<tr>
<td>1010-121</td>
<td>Attenuator, 40 dB, 100W, DC to 18 GHz, N(m)-N(f)</td>
<td></td>
</tr>
<tr>
<td>1010-128-R</td>
<td>Attenuator, 40 dB, 150W, DC to 3 GHz, N(m)-N(f)</td>
<td></td>
</tr>
</tbody>
</table>

## Miscellaneous Accessories

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>633-27</td>
<td>Rechargeable Battery, Ni-MH</td>
<td></td>
</tr>
<tr>
<td>806-141</td>
<td>Automotive Cigarette Lighter/12 Volt DC Adapter</td>
<td></td>
</tr>
<tr>
<td>40-168-R</td>
<td>AC/DC Adapter</td>
<td></td>
</tr>
<tr>
<td>2000-1029</td>
<td>Battery Charger, NiMH, w/ Universal Power Supply</td>
<td></td>
</tr>
<tr>
<td>551-1691-R</td>
<td>USB to RS-232 Adapter Cable</td>
<td></td>
</tr>
<tr>
<td>800-441</td>
<td>Serial Interface Cable</td>
<td></td>
</tr>
<tr>
<td>65717</td>
<td>Soft Carrying Case</td>
<td></td>
</tr>
<tr>
<td>67135</td>
<td>Site Master Backpack</td>
<td></td>
</tr>
<tr>
<td>760-243-R</td>
<td>Transit Case</td>
<td></td>
</tr>
<tr>
<td>ODTF-1</td>
<td>Optical DTF Module</td>
<td></td>
</tr>
<tr>
<td>2300-347</td>
<td>Handheld Software Tools CDROM</td>
<td></td>
</tr>
</tbody>
</table>
## Power Monitor Detectors

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>5400-71N50</td>
<td>Detector, 0.001 to 3 GHz, N(m), 50W</td>
</tr>
<tr>
<td>5400-71N75</td>
<td>Detector, 0.001 to 3 GHz, N(m), 75W</td>
</tr>
<tr>
<td>560-7N50B</td>
<td>Detector, 10 MHz to 20 GHz, N(m), 50 W</td>
</tr>
<tr>
<td>560-7S50B</td>
<td>Detector, 10 MHz to 20 GHz, WSMA(m), 50 W</td>
</tr>
<tr>
<td>560-7K50</td>
<td>Detector, 10 MHz to 40 GHz, K(m), 50 W</td>
</tr>
<tr>
<td>560-7VA50</td>
<td>Detector, 10 MHz to 50 GHz, V(m), 50 W</td>
</tr>
</tbody>
</table>

## Power Monitor Extender Cables

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>800-109</td>
<td>7.6 m (25 ft)</td>
</tr>
<tr>
<td>800-111</td>
<td>30.5 m (100 ft)</td>
</tr>
</tbody>
</table>

## High Accy Power Meter Acc

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSN50</td>
<td>High Accuracy Power Sensor, 50 MHz to 6 GHz</td>
</tr>
<tr>
<td>MA24104A</td>
<td>Inline High Power Sensor, 600 MHz to 4 GHz</td>
</tr>
<tr>
<td>40-168-R</td>
<td>AC-DC Adapter</td>
</tr>
<tr>
<td>800-441</td>
<td>Serial Interface Cable</td>
</tr>
<tr>
<td>3-1010-122</td>
<td>Attenuator, 20 dB, 5 Watt, DC to 12.4 GHz, N(m)-N(f)</td>
</tr>
<tr>
<td>1010-127-R</td>
<td>Attenuator, 30 dB, 150W, DC to 3 GHz, N(m)-N(f)</td>
</tr>
<tr>
<td>3-1010-123</td>
<td>Attenuator, 30 dB, 50 Watt, DC to 8.5 GHz, N(m)-N(f)</td>
</tr>
<tr>
<td>3-1010-124</td>
<td>Attenuator, 40 dB, 100W, DC to 8.5 GHz, N(m)-N(f), Uni-directional</td>
</tr>
<tr>
<td>1010-128-R</td>
<td>Attenuator, 40 dB, 150W, DC to 3 GHz, N(m)-N(f)</td>
</tr>
</tbody>
</table>

## Documentation

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>10580-00100</td>
<td>S33xD Programming Manual (available on disk or at <a href="http://www.us.anritsu.com">www.us.anritsu.com</a>)</td>
</tr>
<tr>
<td>10580-00101</td>
<td>S331D Maintenance Manual</td>
</tr>
</tbody>
</table>
Performance Specifications

Performance specifications are provided in Table 1-1. All specifications apply when calibrated at ambient temperature after a five minute warm up. Typical values are given for reference, and are not guaranteed.

Table 1-1. Performance Specifications (1 of 3)

<table>
<thead>
<tr>
<th>Cable and Antenna Analyzer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency Range:</td>
</tr>
<tr>
<td>Frequency Accuracy:</td>
</tr>
<tr>
<td>Frequency Resolution:</td>
</tr>
<tr>
<td>Output Power:</td>
</tr>
<tr>
<td>Immunity to Interfering Signals:</td>
</tr>
<tr>
<td>Measurement speed:</td>
</tr>
<tr>
<td>Number of data points:</td>
</tr>
<tr>
<td>Return Loss:</td>
</tr>
<tr>
<td>Resolution:</td>
</tr>
<tr>
<td>VSWR:</td>
</tr>
<tr>
<td>Resolution:</td>
</tr>
<tr>
<td>Cable Loss:</td>
</tr>
<tr>
<td>Resolution:</td>
</tr>
<tr>
<td>Measurement Accuracy:</td>
</tr>
<tr>
<td>Distance-To-Fault Vertical Range:</td>
</tr>
<tr>
<td>Return Loss:</td>
</tr>
<tr>
<td>VSWR:</td>
</tr>
<tr>
<td>Horizontal Range:</td>
</tr>
<tr>
<td>Horizontal Resolution (rectangular windowing):</td>
</tr>
</tbody>
</table>

Where Vp is the relative propagation velocity of the cable and DF is the stop frequency minus the start frequency (in Hz).
### Chapter 1 General Information

Table 1-1. Performance Specifications (2 of 3)

<table>
<thead>
<tr>
<th>Power Monitor (Option 5, with external detector)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Measurement Range:</td>
<td>–50 dBm to +16 dBm (10 nW to 40 mW)</td>
</tr>
<tr>
<td>Offset Range:</td>
<td>0 dB to +60 dB</td>
</tr>
<tr>
<td>Display Range:</td>
<td>–80 dBm to 80 dBm</td>
</tr>
<tr>
<td>Resolution:</td>
<td>0.1 dB, 0.1 xW</td>
</tr>
<tr>
<td>Measurement Accuracy:</td>
<td>±1 dB maximum for &gt;–40 dBm and &lt;18 GHz using 560-7N50B (see uncertainty curves)</td>
</tr>
</tbody>
</table>

### High Accuracy Power Meter (Option 19)

Compatible Sensors: PSN50 and MA24104A

**PSN50 High Accuracy Power Sensor:**
- Frequency Range: 50 MHz to 6 GHz
- Measurement Range: –30 dBm to +20 dBm
- Sensor Linearity: ± 0.13 dB
- Input Connector: Type N, male, 50Ω

Refer to the PSN50 Technical Data Sheet, PN: 11410-00423, for complete specifications.

**MA24104A Inline High Power Sensor:**
- Frequency Range: 600 MHz to 4 GHz
- Measurement Range: +3 dBm to +51.76 dBm (2 mW to 150 W)
- Sensor Linearity: ± 0.13 dB
- Input Connector: Type N, female, 50Ω
- Output Connector: Type N, female, 50Ω

Refer to the MA24104A Technical Data Sheet, PN: 11410-00483, for complete specifications.
## General

<table>
<thead>
<tr>
<th>Description</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language Support</td>
<td>English, Spanish, French, German, Chinese, Japanese</td>
</tr>
<tr>
<td>Internal Trace Memory</td>
<td>Up to 300 traces</td>
</tr>
<tr>
<td>Setup Configurations</td>
<td>10</td>
</tr>
<tr>
<td>Display</td>
<td>Standard color TFT (640x480) display with variable brightness control</td>
</tr>
<tr>
<td>Inputs and Outputs Ports:</td>
<td></td>
</tr>
<tr>
<td>RF Out</td>
<td>Type N, female, 50Ω</td>
</tr>
<tr>
<td>Maximum Input without Damage:</td>
<td>+23 dBm, ± 50 VDC</td>
</tr>
<tr>
<td>Serial Interface</td>
<td>RS-232 9 pin D-sub, three wire serial</td>
</tr>
<tr>
<td>Electromagnetic Compatibility:</td>
<td>Meets European Community requirements for CE marking</td>
</tr>
<tr>
<td>Safety</td>
<td>Conforms to EN 61010-1 for Class 1 portable equipment</td>
</tr>
<tr>
<td>Temperature</td>
<td></td>
</tr>
<tr>
<td>Operating:</td>
<td>-10°C to 55°C, humidity 85% or less</td>
</tr>
<tr>
<td>Non-operating:</td>
<td>-51°C to +71°C (store battery separately between 0°C and +40°C for any prolonged non-operating storage period)</td>
</tr>
<tr>
<td>Power Supply</td>
<td></td>
</tr>
<tr>
<td>External DC Input</td>
<td>+12 to +15 volt dc, 3A maximum</td>
</tr>
<tr>
<td>Internal:</td>
<td>NiMH battery: 10.8 volts, 1800 mAh</td>
</tr>
<tr>
<td>Dimensions</td>
<td></td>
</tr>
<tr>
<td>Size (w x h x d):</td>
<td>25.4 cm x 17.8 cm x 6.1 cm (10.0 in x 7.0 in x 2.4 in)</td>
</tr>
</tbody>
</table>
Preventive Maintenance

Site Master preventive maintenance consists of cleaning the unit and inspecting and cleaning the RF connectors on the instrument and all accessories.

Clean the Site Master with a soft, lint-free cloth dampened with water or water and a mild cleaning solution.

**CAUTION:** To avoid damaging the display or case, do not use solvents or abrasive cleaners.

Clean the RF connectors and center pins with a cotton swab dampened with denatured alcohol. Visually inspect the connectors. The fingers of the N (f) connectors and the pins of the N (m) connectors should be unbroken and uniform in appearance. If you are unsure whether the connectors are good, gauge the connectors to confirm that the dimensions are correct.

Visually inspect the test port cable(s). The test port cable should be uniform in appearance, not stretched, kinked, dented, or broken.

Calibration

The Site Master is a field portable unit operating in the rigors of the test environment. An Open-Short-Load (OSL) calibration, InstaCal calibration, FlexCal calibration with open-short-load, or FlexCal calibration with an InstaCal module should be performed prior to making a measurement in the field (see Calibration, page 3-2). A built-in temperature sensor in the Site Master advises the user when the internal temperature has exceeded a measurement accuracy window, and the user is advised to perform another calibration in order to maintain the integrity of the measurement.

**NOTES:**
For best calibration results—compensation for all measurement uncertainties—ensure that the Open/Short/Load is at the end of the test port or optional extension cable; that is, at the same point that you will connect the antenna or device to be tested.

For best results, use a phase stable Test Port Extension Cable (see Optional Accessories). If you use a typical laboratory cable to extend the Site Master test port to the device under test, cable bending subsequent to the OSL calibration will cause uncompensated phase reflections inside the cable. Thus, cables which are NOT phase stable may cause measurement errors that are more pronounced as the test frequency increases.

For optimum calibration, Anritsu recommends using precision calibration components.
InstaCal Module

The Anritsu InstaCal module can be used in place of discrete components to calibrate the Site Master. The InstaCal module can be used to perform an Open, Short and Load (OSL) or a FlexCal calibration procedure. Calibration of the Site Master with the InstaCal takes approximately 45 seconds (see Calibration, page 3-2). Unlike a discrete calibration component, the InstaCal module cannot be used at the top of the tower to conduct load or insertion loss measurements.

Anritsu recommends annual verification of the InstaCal module to verify performance with precision instrument data. The verification may be performed at a local Anritsu Service Center or at the Anritsu factory.

Annual Verification

Anritsu recommends an annual calibration and performance verification of the Site Master and the OSL calibration components and InstaCal module by local Anritsu service centers. Anritsu service centers are listed in Table 1-2 on the following page.

The Site Master itself is self-calibrating, meaning that there are no field-adjustable components. However, the OSL calibration components are crucial to the integrity of the calibration and therefore, must be verified periodically to ensure performance conformity. This is especially important if the OSL calibration components have been accidentally dropped or over-torqued.

ESD Precautions

The Site Master, like other high performance instruments, is susceptible to ESD damage. Very often, coaxial cables and antennas build up a static charge, which, if allowed to discharge by connecting to the Site Master, may damage the Site Master input circuitry. Site Master operators should be aware of the potential for ESD damage and take all necessary precautions. Operators should exercise practices outlined within industry standards like JEDEC-625 (EIA-625), MIL-HDBK-263, and MIL-STD-1686, which pertain to ESD and ESDS devices, equipment, and practices.

As these apply to the Site Master, it is recommended to dissipate any static charges that may be present before connecting the coaxial cables or antennas to the Site Master. This may be as simple as temporarily attaching a short or load device to the cable or antenna prior to attaching to the Site Master. It is important to remember that the operator may also carry a static charge that can cause damage. Following the practices outlined in the above standards will insure a safe environment for both personnel and equipment.

Anritsu Service Centers

To locate the Anritsu Service Center nearest you, please visit:
www.anritsu.com/contact.asp

Mode References

The term “VNA” in reference to the Site Master denotes cable and antenna analyzer modes.
Chapter 2
Functions and Operations

Introduction

This chapter provides a brief overview of the Site Master functions and operations, providing the user with a starting point for making basic measurements. For more detailed information, refer to the specific chapters for the measurements being made.

The Site Master is designed specifically for field environments and applications requiring mobility. As such, it is a lightweight, handheld, battery operated unit which can be easily carried to any location, and is capable of up to 1.5 hours of continuous operation from a field replaceable battery for extended time in the field. Built-in energy conservation features allow battery life to be further extended. The Site Master can also be powered by an external DC source. The external source can be either the Anritsu AC-DC Adapter (P/N 40-168-R) or the Automotive Cigarette Lighter Adapter (P/N 806-141). Both items are standard accessories.

Test Connector Panel

The connectors and indicators located on the test panel (Figure 2-1) are listed and described below.

Figure 2-1. Test Connector Panel

12-15VDC (3A) 12 to 15 Vdc @ 3A input to power the unit or for battery charging.

WARNING

When using the AC-DC Adapter, always use a three-wire power cable connected to a three-wire power line outlet. If power is supplied without grounding the equipment in this manner, there is a risk of receiving a severe or fatal electric shock, or damaging the equipment.
| **Battery Charging** | Illuminates when the battery is being charged. The indicator automatically shuts off when the battery is fully charged. |
| **External Power** | Illuminates when the Site Master is being powered by the external charging unit. |
| **Serial Interface** | RS232 DB9 interface to a COM port on a personal computer (for use with the Anritsu Handheld Software Tools program) or to a supported printer. |
| **RF Out/Reflection 50Ω** | RF output, 50 Ω impedance, for reflection measurements. Maximum input is +23 dBm at ±50 Vdc. |
| **RF Detector (Option 5)** | RF detector connector for Power Monitor measurements using an external detector. Refer to the table of available RF Detectors on page 1-3. |
Display Overview

Figure 2-2 illustrates some of the key information areas of the S331D display.

Figure 2-2. S331D Display Overview
Front Panel Overview

The Site Master menu-driven user interface is easy to use and requires little training. Hard keys on the front panel are used to initiate function-specific menus. There are four function hard keys located below the status window: Mode, Frequency/Distance, Amplitude and Measure/Display.

There are seventeen keypad hard keys located to the right of the status window. Twelve of the keypad hard keys perform more than one function, depending on the current mode of operation. The dual purpose keys are labeled with one function in black, the other in blue.

There are also six soft keys that change function depending upon the current mode selection. The current soft key function is indicated in the soft key menu area to the right of the status window. The locations of the different keys are illustrated in Figure 2-3.

The following sections describe the various key functions.
Function Hard Keys

**MODE**  
Opens the mode selection box (below). Use the Up/Down arrow key to select a mode. Press the ENTER key to implement.

<table>
<thead>
<tr>
<th>Measurement Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freq - SWR</td>
</tr>
<tr>
<td><strong>Return Loss</strong></td>
</tr>
<tr>
<td>Cable Loss - One Port</td>
</tr>
<tr>
<td>DTF - SWR</td>
</tr>
<tr>
<td>Return Loss</td>
</tr>
<tr>
<td>Power Monitor (External Detector)</td>
</tr>
<tr>
<td>High Accuracy Power Meter</td>
</tr>
</tbody>
</table>

*NOTE: Available mode selections will vary according to model number and options installed.*

**FREQ/DIST**  
Displays the Frequency or Distance to Fault soft key menus depending on the measurement mode (see page 2-11).

**AMPLITUDE**  
Displays the amplitude soft key menu for the current operating mode (see page 2-13).

**MEAS/DISP**  
Displays the measurement and display soft key menus for the current operating mode (see page 2-14).
Keypad Hard Keys

This section contains an alphabetical listing of the Site Master front panel keypad controls along with a brief description of each. More detailed descriptions of the major function keys follow.

The following keypad hard key functions are printed in **black** on the keypad keys.

- **0-9**
  - These keys are used to enter numerical data as required to setup or perform measurements.

- **+/–**
  - The plus/minus key is used to enter positive or negative values as required to setup or perform measurements.

- **•**
  - The decimal point is used to enter decimal values as required to setup or perform measurements.

- **ESCAPE/CLEAR**
  - Exits the present operation or clears the status window. If a parameter is being edited, pressing this key will clear the value currently being entered and restore the last valid entry. Pressing this key again will close the parameter. During normal sweeping, pressing this key will move up one menu level.

- **Up/Down Arrows**
  - Increments or decrements a parameter value. The specific parameter value affected typically appears in the message area of the LCD.

- **ENTER**
  - Implements the current action or parameter selection.

- **ON/OFF**
  - Turns the Anritsu Site Master on or off. When turned on, the saved system state at the last turn-off is restored. If the **ESCAPE/CLEAR** key is held down while the **ON/OFF** key is pressed, the factory preset state will be restored.

- **SYS**
  - Allows selection of system and application setup parameters and the display language.
The following keypad hard key functions are printed in **blue** on the keypad keys.

- **This key is used to adjust the display brightness. Use the Up/Down arrow key and **ENTER** to adjust the brightness.**

- **AUTO SCALE**
  Automatically scales the status window for optimum resolution in cable and antenna analyzer mode.

- **LIMIT**
  Displays the limit line menu for the current operating mode when in cable, antenna analyzer.

- **MARKER**
  Displays the marker menu of the current operating mode when in cable, antenna analyzer mode.

- **PRINT**
  Prints the current display to the selected printer via the RS232 serial port.

- **RECALL DISPLAY**
  Recalls a previously saved trace from memory. When the key is pressed, a Recall Trace selection box appears on the display. Select a trace using the Up/Down arrow key and press the **ENTER** key to implement.

- **RECALL SETUP**
  Recalls a previously saved setup from a memory location. When the key is pressed, a Recall Setup selection box appears on the display. Select a setup using the Up/Down arrow key and press the **ENTER** key to implement. Setup 0 recalls the factory preset state for the current mode.

- **RUN HOLD**
  When in the Hold mode, this key starts the Site Master sweeping and provides a Single Sweep Mode trigger; when in the Run mode, it pauses the sweep. When in the Hold mode, the hold symbol (page 2-17) appears on the display. Hold mode can be used to conserve battery power.

- **SAVE DISPLAY**
  Saves up to 300 displayed traces to non-volatile memory. When the key is pressed, the Trace Name: box appears. Use the soft keys to enter up to 16 alphanumeric characters for that trace name and press the **ENTER** key to save the trace.

- **SAVE SETUP**
  Saves the current system setup to an internal non-volatile memory location. The number of locations available varies with the model number and installed options. There are ten available locations in cable and antenna analyzer mode. When the key is pressed, a Save Setup selection box appears on the status window. Use the Up/Down arrow key to select a setup and press the **ENTER** key to implement.

- **START CAL**
  Starts the calibration in SWR, Return Loss, Cable Loss, or DTF measurement modes.
Soft Keys

Each keypad key opens a set of soft key selections. Each of the soft keys has a corresponding soft key label area on the status window. The label identifies the function of the soft key for the current Mode selection.

The following figures show the soft key labels for each Mode selection.

![Figure 2-5. Return Loss Mode Soft Key Labels](image-url)
Figure 2-6. Distance to Fault Mode Soft Key Labels
Figure 2-7. High Accuracy Power Sensor Mode (Option 19) Soft Keys

Figure 2-8. SYS Key Menu in Cable and Antenna Analyzer Mode
### Frequency Menu

The frequency and distance menu for cable and antenna analyzer measurements provides for setting sweep frequency end points when Freq mode is selected. Selected frequency values may be changed using the keypad or Up/Down arrow key.

- **F1** — Opens the F1 parameter for data entry. This is the start value for the frequency sweep. Press **ENTER** when data entry is complete.

- **F2** — Opens the F2 parameter for data entry. This is the stop value for the frequency sweep. Press **ENTER** when data entry is complete.

- **Signal Standard** — Allows selection of the signal standard to be used. Select from the available international standards (Appendix C).

### Distance Menu

Provides for setting Distance to Fault parameters when a DTF mode is selected. Choosing DIST causes the soft keys, below, to be displayed and the corresponding values to be shown in the message area. Selected distance values may be changed using the keypad or Up/Down arrow key.

- **D1** — Opens the start distance (D1) parameter for data entry. This is the start value for the distance range (D1 default = 0). Press **ENTER** when data entry is complete.

- **D2** — Opens the end distance (D2) parameter for data entry. This is the end value for the distance range. Press **ENTER** when data entry is complete.

- **DTF Aid** — Provides interactive help to optimize DTF set up parameters. Use the Up/Down arrow key to select a parameter to edit. Press **ENTER** when data entry is complete.

- **More** — Selects the Distance Sub-Menu, detailed below.
  - **Loss** — Opens the Cable Loss parameter for data entry. Enter the loss per meter (or foot) for the type of transmission line being tested. Press **ENTER** when data entry is complete. (Range is 0.5 to 5.0 dB/m, 1.524 dB/ft)
  - **Prop Vel** (relative propagation velocity) — Opens the Propagation Velocity parameter for data entry. Enter the propagation velocity for the type of transmission line being tested. Press **ENTER** when data entry is complete. (Range is 0.010 to 1.000)
  - **Cable** — Opens a list of cable three common coaxial folders (1000 MHz, 2000 MHz, and 2500 MHz) and one custom folder. Select either folder and use the Up/Down arrow key and **ENTER** to make a selection. This feature provides a rapid means of setting both cable loss and propagation velocity. (Refer to Appendix A for a listing of common coaxial cables showing values for Relative Propagation Velocity and Nominal Attenuation in dB/m or dB/ft @ 1000 MHz, 2000 MHz and 2500 MHz.) The custom cable folder can consist of up to 49 user-defined cable parameters uploaded via the Handheld Software Tools program.
  - **Window** — Opens a menu of FFT windowing types for the DTF calculation. Scroll the menu using the Up/Down arrow key and make a selection with the **ENTER** key. Refer to Appendix B for details on windowing.
  - **Back** — Returns to the Distance Menu.
Choosing **MARKER** in cable and antenna analyzer freq and dist mode causes the soft keys, below, to be displayed and the corresponding values to be shown in the message area. Selected frequency marker or distance marker locations may be changed using the keypad or Up/Down arrow key.

- **M1** — Selects the M1 marker parameter and opens the M1 marker second level menu.
  - **On/Off** — Turns the selected marker on or off.
  - **Edit** — Opens the selected marker parameter for data entry. Press **ENTER** when data entry is complete or **ESCAPE** to restore the previous value.
  - **Marker To Peak** — Places the selected marker at the frequency or distance with the maximum amplitude value.
  - **Marker To Valley** — Places the selected marker at the frequency or distance with the minimum amplitude value.
  - **Back** — Returns to the Main Markers Menu.

- **M2** through **M4** — Selects the marker parameter and opens the marker second level menu.
  - **On/Off** — Turns the selected marker on or off.
  - **Edit** — Opens the selected marker parameter for data entry. Press **ENTER** when data entry is complete or **ESCAPE** to restore the previous value.
  - **Delta (Mx-M1)** — Displays delta amplitude value as well as delta frequency or distance for the selected marker with respect to the M1 marker.
  - **Marker To Peak** — Places the selected marker at the frequency or distance with the maximum amplitude value.
  - **Marker To Valley** — Places the selected marker at the frequency or distance with the minimum amplitude value.
  - **Back** — Returns to the Main Markers Menu.

- **All Off** — Turns all markers off.

- **More** — Opens the continuation of the Marker Menus.
  - **M5** — Selects the M5 marker parameter and opens the M5 second level menu.
    - **On/Off** — Turns the selected marker on or off.
    - **Edit** — Opens the selected marker parameter for data entry. Press **ENTER** when data entry is complete or **ESCAPE** to restore the previous value.
    - **Peak Between M1 & M2** — Places the selected marker at the frequency or distance with the maximum amplitude value between marker M1 and marker M2.
    - **Valley Between M1 & M2** — Places the selected marker at the frequency or distance with the minimum amplitude value between marker M1 and marker M2.
    - **Back** — Returns to the Main Markers Menu.
M6 — Selects the M6 marker parameter and opens the M6 second level menu.

On/Off — Turns the selected marker on or off.

Edit — Opens the selected marker parameter for data entry. Press 
ENTER when data entry is complete or ESCAPE to restore the previous value.

Peak Between M3 & M4 — Places the selected marker at the peak be-
tween marker M3 and marker M4.

Valley Between M3 & M4 — Places the selected marker at the valley
between marker M3 and marker M4.

Back — Returns to the Main Markers Menu.

All Off — Turns all markers off

Back — Returns to the Main Markers Menu.

LIMIT

Pressing LIMIT in cable and antenna analyzer frequency and distance mode activates a menu of limit related functions. Use the corresponding soft key to select the desired limit function. Then use the Up/Down arrow key to change its value, which is displayed in the message area at the bottom of the status window.

Choosing LIMIT in Freq or DTF measurement modes causes the soft keys below to be displayed.

Single Limit — Sets a single limit value in dBm. Menu choices are:

On/Off — Turns the single limit function on or off

Edit — Allows entry of the limit amplitude.

Back — Returns to the previous menu.

Multiple Limits — Sets multiple user defined limits, and can be used to create a limit mask for quick pass/fail measurements.

Segment 1 through Segment 5 — Opens the segment menu.

On/Off — Turns the segment on or off.

Edit — Opens the parameter for data entry.

Prev Segment — Edit or view the parameters of the previous seg-
ment.

Next Segment — Edit or view the parameters of the next segment. If the next segment is off when this button is pressed, the starting point of the next segment will be set equal to the ending point of the current segment.

Back — Returns to the previous menu.

Back — Returns to the previous menu.

Limit Beep — Turns the audible limit beep indicator on or off.
SYS

In cable and antenna analyzer or optional power meter mode, pressing the SYS key displays the following System menu soft key selections:

- **System Options** — Displays a second level of system option functions:
  - **Clock** — Displays a second level of functions:
    - **Hour** — Enter the hour (0-23) using the Up/Down arrow key or the keypad. Press ENTER when data entry is complete or ESCAPE to restore the previous value.
    - **Minute** — Enter the minute (0-59) using the Up/Down arrow key or the keypad. Press ENTER when data entry is complete or ESCAPE to restore the previous value.
    - **Month** — Enter the month (1-12) using the Up/Down arrow key or the keypad. Press ENTER when data entry is complete or ESCAPE to restore the previous value.
    - **Day** — Enter the day using the Up/Down arrow key or the keypad. Press ENTER when data entry is complete or ESCAPE to restore the previous value.
    - **Year** — Enter the year (2003-2036) using the Up/Down arrow key or the keypad. Press ENTER when data entry is complete or ESCAPE to restore the previous value.
  - **Back** — Returns to the top-level SYS menu.

- **Printer** — Displays a menu of supported printers. Use the Up/Down arrow key and ENTER key to make the selection.

- **Units** — Select the unit of measurement (metric or English).

- **Change Date Format** — Toggles the date format between MM/DD/YYYY, DD/MM/YYYY, and YYYY/MM/DD.

- **Back** — Returns to the top-level SYS menu.

- **Application Options** — Application options displays options applicable to particular mode.
  - **CAL Mode** — In cable and antenna analyzer modes, selects either OSL Cal or FlexCal™. FlexCal is a broadband frequency calibration valid from 25 MHz to 4 GHz (2 MHz to 6 GHz with Options 2 and 16). Refer to Calibration, page 3-2, for more information.

- **Self Test** — Start an instrument self test.

- **Status** — In cable and antenna analyzer freq or dist measurement mode, displays the current instrument status, including calibration status, temperature, and battery charge state. Press ESCAPE to return to operation.

- **Language** — Pressing this soft key immediately changes the language used to display messages on the Site Master status window. Choices are English, French, German, Spanish, Chinese, and Japanese. The default language is English.

In Power Monitor mode, pressing the SYS key displays the following System menu soft key selections:

- **System Options** — Displays a second level of system option functions:
  - **Clock** — Displays a second level of functions:
    - **Hour** — Enter the hour (0-23) using the Up/Down arrow key or the keypad. Press ENTER when data entry is complete or ESCAPE to restore the previous value.
- **Minute** — Enter the minute (0-59) using the Up/Down arrow key or the keypad. Press **ENTER** when data entry is complete or **ESCAPE** to restore the previous value.

- **Month** — Enter the month (1-12) using the Up/Down arrow key or the keypad. Press **ENTER** when data entry is complete or **ESCAPE** to restore the previous value.

- **Day** — Enter the day using the Up/Down arrow key or the keypad. Press **ENTER** when data entry is complete or **ESCAPE** to restore the previous value.

- **Year** — Enter the year (2003-2036) using the Up/Down arrow key or the keypad. Press **ENTER** when data entry is complete or **ESCAPE** to restore the previous value.

- **Back** — Returns to the top-level SYS menu.

- **Printer** — Displays a menu of supported printers. Use the Up/Down arrow key and **ENTER** key to make the selection.

- **Units** — Select the unit of measurement (metric or English).

- **Change Date Format** — Toggles the date format between MM/DD/YYYY, DD/MM/YYYY, and YYYY/MM/DD.

- **Back** — Returns to the top-level SYS menu.

- **Self Test** — Start an instrument self test.

- **Status** — In cable and antenna analyzer freq or dist measurement mode, displays the current instrument status, including calibration status, temperature, and battery charge state. Press **ESCAPE** to return to operation.

- **Language** — Pressing this soft key immediately changes the language used to display messages on the Site Master status window. Choices are English, French, German, Spanish, Chinese, and Japanese. The default language is English.
Power Monitor, External Detector (Option 5)

Selecting Power Monitor (External Detector) from the mode menu causes the soft keys, described below, to be displayed and the corresponding values shown in the message area.

- **Units** — Toggles between dBm and Watts.
- **Rel** — Turns relative mode OFF, if currently ON. If relative mode is currently OFF, turns it ON and causes the power level to be measured and saved as the base level. Subsequent measurements are then displayed relative to this saved value. With units of dBm, relative mode displays dBr; with units of Watts, relative mode displays % (percent).
- **Offset dB** — Turns Offset OFF, if currently ON. If Offset is currently OFF, turns it ON and opens the Offset parameter for data entry (0-60). Press ENTER when data entry is complete. Offset is the attenuation (in dB) inserted in the line between the DUT and the RF detector. The attenuation is added to the measured input level prior to display.
- **Zero** — Turns Zero OFF, if currently ON. If Zero is currently OFF, this soft key turns it ON and initiates collection of a series of power level samples, which are averaged and saved. This saved value is then subtracted from subsequent measurements prior to display.
Table 2-1 provides a listing of the symbols used as condition indicators on the LCD status window.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>![HOLD]</td>
<td>Site Master is in Hold for power conservation. To resume sweeping, press the RUN/HOLD key. When running on battery power, after 10 minutes without a key press, the Site Master will automatically activate the power conservation mode.</td>
</tr>
<tr>
<td>![∫dX]</td>
<td>Integrator Failure. Intermittent integrator failure may be caused by interference from another antenna. Persistent integrator failure indicates a need to return the Site Master to the nearest Anritsu service center for repair.</td>
</tr>
<tr>
<td>![T]</td>
<td>Lock fail indication. Check battery. (If the Site Master fails to lock with a fully charged battery, call your Anritsu Service Center.)</td>
</tr>
<tr>
<td>![°C]</td>
<td>When calibration is performed, the Site Master stores the temperature. If the temperature drifts outside the specified range, this icon will appear at the top of the status window, and the Cal Off message will be displayed. A recalibration at the current temperature is recommended.</td>
</tr>
<tr>
<td>![Battery]</td>
<td>Indicates the remaining charge on the battery. The inner white rectangle grows longer as the battery charge depletes.</td>
</tr>
<tr>
<td>![Clock]</td>
<td>Indicates internal data processing.</td>
</tr>
<tr>
<td>Cal On</td>
<td>The Site Master has been calibrated with discrete Open, Short and Load components.</td>
</tr>
<tr>
<td>Cal On!</td>
<td>The Site Master has been calibrated with the InstaCal Module.</td>
</tr>
<tr>
<td>Cal Off</td>
<td>The Site Master has not been calibrated.</td>
</tr>
<tr>
<td>FlexCal On</td>
<td>The Site Master has been calibrated with discrete Open, Short and Load components for the frequency supported by the unit.</td>
</tr>
<tr>
<td>FlexCal On!</td>
<td>The Site Master has been calibrated with the InstaCal Module for the frequency supported by the unit.</td>
</tr>
</tbody>
</table>
Self Test

At turn-on, the Site Master runs through a series of quick checks to ensure the system is functioning properly. Note that the voltage and temperature are displayed in the lower left corner below the self test message. If the battery is low, or if the ambient temperature is not within the specified operational range, Self Test will fail. If Self Test fails and the battery is fully charged and the Site Master is within the specified operating temperature range, call your Anritsu Service Center found from:
http://www.anritsu.com/Contact.asp
Error Messages

Self Test Error Messages

A listing of Self Test Error messages is provided in Table 2-2.

Table 2-2. Self Test Error Messages

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Battery Low</td>
<td>Battery voltage is less than 9.5 volts. Charge battery. <em>If condition persists, call your Anritsu Service Center.</em></td>
</tr>
<tr>
<td>External Power Low</td>
<td>External supply voltage is less than 10 volts. <em>Call your Anritsu Service Center</em></td>
</tr>
<tr>
<td>PLL Failed</td>
<td>Phase-locked loops failed to lock. Charge battery. <em>If condition persists with a fully charged battery, call your Anritsu Service Center</em></td>
</tr>
<tr>
<td>Integrator Failed</td>
<td>Integration circuit could not charge to a valid level. Charge battery. <em>If condition persists with a fully charged battery, call your Anritsu Service Center.</em></td>
</tr>
<tr>
<td>EEPROM R/W Failed</td>
<td>Non-volatile memory system has failed. <em>Call your Anritsu Service Center.</em></td>
</tr>
<tr>
<td>Out Of Temp. Range</td>
<td>Ambient temperature is not within the specified operating range. <em>If the temperature is within the specified operating range and the condition persists, call your Anritsu Service Center.</em></td>
</tr>
<tr>
<td>RTC Battery Low</td>
<td>The internal real-time clock battery is low. A low or drained clock battery will affect the date stamp on saved traces. <em>Contact your nearest Anritsu Service Center.</em></td>
</tr>
<tr>
<td>Battery Cal Lost</td>
<td>Battery communication failed. The indicated battery charge status may be invalid. <em>If condition persists, call your Anritsu Service Center.</em></td>
</tr>
<tr>
<td>Memory Fail</td>
<td>The EEPROM test on the Site Master main board has failed. <em>If condition persists, call your Anritsu Service Center.</em></td>
</tr>
<tr>
<td>The time and date</td>
<td>The time and date are not properly set in the Site Master. <em>If condition persists, call your Anritsu Service Center.</em></td>
</tr>
</tbody>
</table>

Note: Page 1-11 provides contact information for Anritsu Service Centers.
## Range Error Messages

A listing of Range Error messages is provided in Table 2-3.

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RANGE ERROR: F1 &gt; F2</td>
<td>The start (F1) frequency is greater than the stop (F2) frequency.</td>
</tr>
<tr>
<td>RANGE ERROR: D1 &gt; D2</td>
<td>The start (D1) distance is greater than the stop (D2) distance.</td>
</tr>
</tbody>
</table>
| RANGE ERROR: D2 > DMax=xx.x ft (m) | The stop distance (D2) exceeds the maximum unaliased range. This range is determined by the frequency span, number of points, and relative propagation velocity:  

\[ \text{Maximum Unaliased Range} = \frac{(1.5 \times 10^8)(dp - 1)(Vf)}{F2 - F1} \]  

Where:  
- \( dp \) is the number of data points (130, 259, or 517)  
- \( Vf \) is the relative propagation velocity  
- \( F2 \) is the stop frequency in Hz  
- \( F1 \) is the start frequency in Hz  
- Maximum Unaliased Range is in meters |
| RANGE ERROR: TOP<=BOTTOM | The SWR scale parameter top value is less than or equal to its bottom value. |
| RANGE ERROR: TOP>=BOTTOM | The RL scale parameter top value is greater than or equal to its bottom value. |
InstaCal Error Messages

If the serial number of the connected InstaCal module does not match the serial number stored in the Site Master, the following message is displayed:

The InstaCal characterization data stored in the Site Master is for a module different than the one currently connected. Site Master contains data for InstaCal module S/N: xxxxx Currently connected InstaCal Module S/N: xxxxx Would you like to overwrite the previously loaded InstaCal characterization?

Press the YES soft key to update the stored InstaCal characterization to use the currently connected module.

Press the NO soft key to keep the stored InstaCal characterization.

A listing of possible InstaCal error messages is provided in Table 2-4.

Table 2-4. InstaCal Error Messages

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failed to read serial number of InstaCal module</td>
<td>The Site Master was unable to read the InstaCal module serial number.</td>
</tr>
<tr>
<td>Failed to successfully transfer instacal module data to Site Master</td>
<td>The Site Master was unable to transfer all necessary data between the InstaCal module and the Site Master.</td>
</tr>
<tr>
<td>Failed to set baud with InstaCal module</td>
<td>The Site Master was unable to establish communication with the InstaCal module.</td>
</tr>
</tbody>
</table>
High Accuracy Power Meter (Option 19) Error Messages

The following error messages could be displayed on the Site Master when using the High Accuracy Power Meter mode with Power Sensor PSN50. If any error condition persists, contact your local Anritsu Service Center.

Table 2-5.  Option 19 Error Messages

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning! Power Supply Error</td>
<td>Verify that the supply is connected properly.</td>
</tr>
<tr>
<td>Warning! RF Power Level is too high</td>
<td>The specified upper measurement range is +20 dBm. Do not exceed the specification.</td>
</tr>
<tr>
<td>Warning! Sensor not zeroed properly. Zero sensor again</td>
<td>The sensor must be zeroed with nothing connected to it.</td>
</tr>
<tr>
<td>Warning! Specified temperature range (0 to 50°C) exceeded</td>
<td>The PSN50 sensor temperature range is 0 to 50°C.</td>
</tr>
<tr>
<td>Warning! Temperature has changed. Zero sensor again</td>
<td>The temperature changed more than the allowable limit after the sensor was zeroed.</td>
</tr>
</tbody>
</table>

Table 2-6.  General Error Messages

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAL Incomplete</td>
<td>A complete open, short, and load calibration must be performed before calibration can be turned on.</td>
</tr>
<tr>
<td>Dist Requires F1 &lt; F2</td>
<td>Valid distance to fault plots require a non-zero frequency span.</td>
</tr>
<tr>
<td>Invalid Sweep Data</td>
<td>The sweep data is invalid.</td>
</tr>
<tr>
<td>Use Options menu to select a printer</td>
<td>Attempting to print a display with no printer selected. Select a printer, then retry.</td>
</tr>
<tr>
<td>Flexcal is not suitable for this case, Change To OSL CAL mode (SYS-Options)</td>
<td>The cable is too long or too reflective for FlexCal to work. OSL cal must be used instead.</td>
</tr>
<tr>
<td>Cannot zero input signal too high</td>
<td>Attempting to perform a Power Meter zero adjust function with an input of greater than –20 dBm.</td>
</tr>
</tbody>
</table>
Battery Information

Charging a New Battery

The NiMH battery supplied with the Site Master has already completed three charge and discharge cycles at the factory and full battery performance should be realized after your first charge.

NOTE: Use only Anritsu approved batteries, adapters and chargers with this instrument. The battery will not charge if the battery temperature is above 45°C or below 0°C.

Charging the Battery in the Site Master

The battery can be charged while installed in the Site Master.

Step 1. Turn the Site Master off.

Step 2. Connect the AC-DC adapter (Anritsu part number: 40-168-R) to the Site Master charging port.

Step 3. Connect the AC adapter to a 120 VAC or 240 VAC power source as appropriate for your application.

The green external power indicator on the Site Master will illuminate, indicating the presence of external DC power, the battery charge indicator will light, and the battery will begin fast charging. If the battery fails to charge, contact your nearest Anritsu service center.

NOTES: If the battery temperature exceeds 50°C while charging, the charging will stop and the charge indicator will turn off. Charging will resume automatically when the temperature drops below 50°C.

Charging the Battery in the Optional Charger

Up to two batteries can be charged sequentially in the optional battery charger.

Step 1. Remove the NiMH battery from your Site Master and place it in the optional charger (Anritsu part number 2000-1029).

Step 2. Connect the lead from the AC-DC adapter to the charger.

Step 3. Connect the AC-DC adapter to a 120 VAC or 240 VAC power source as appropriate for your application.

Each battery holder in the optional charger has an LED charging status indicator. The LED color changes as the battery is charged:

Red indicates the battery is charging
Green indicates the battery is fully charged
Yellow indicates the battery is in a waiting state (see below).

A yellow light may occur because the battery became too warm during the charge cycle. The charger will allow the battery to cool off before continuing the charge. A yellow light may also indicate that the charger is alternating charge to each of the two batteries.
A blinking red light indicates less than 13 VDC is being supplied to the charger stand. Check that the correct AC charger adapter is connected to the charger stand. If the battery fails to charge, contact your nearest Anritsu Service Center.

**Determining Remaining Battery Life**

When the AC-DC adapter is unplugged from the Site Master, the battery indicator symbol will be continuously displayed at the top left corner of the Site Master display (Figure 2-7). A totally black bar within the battery icon indicates a fully charged battery. When LOW BATT replaces the battery indicator bar at the top left corner, a couple of minutes of measurement time remains. If a flashing LOW BATT is accompanied by an audio beep at the end of each trace, the battery has approximately one minute of useable time remaining.

---

**Figure 2-7. Site Master Battery Indicator**

Once all the power has drained from the battery, the Site Master LCD will fade. At this point, your Site Master will switch itself off and the battery will need to be recharged.

During operation, the battery condition can be viewed by pressing the SYS key and selecting the Self Test soft key (Figure 2-8). The battery condition will be displayed as a percentage of charge remaining.

---

**Selftest**

<table>
<thead>
<tr>
<th>Item</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>24°C</td>
</tr>
<tr>
<td>Memory</td>
<td>PASSED</td>
</tr>
<tr>
<td>RTC Battery</td>
<td>3.1V</td>
</tr>
<tr>
<td>Voltage</td>
<td>Battery (11.1V)</td>
</tr>
<tr>
<td>Battery Cal</td>
<td>PASSED</td>
</tr>
<tr>
<td>Battery Charge</td>
<td>84% (I = -743mA)</td>
</tr>
<tr>
<td>VNA PLL</td>
<td>PASSED</td>
</tr>
<tr>
<td>VNA Integrator</td>
<td>PASSED</td>
</tr>
</tbody>
</table>

Press **ESCAPE** to return.

---

**Figure 2-8. Self Test Display**
Battery Life

The NiMH battery will last longer and perform better if allowed to completely discharge before recharging. For maximum battery life, it is recommended that the NiMH battery be completely discharged and recharged once every three months.

The charging circuitry inside the Site Master is designed to optimize the life of the battery. If the temperature inside the instrument exceeds 50°C, the current charge cycle will be suspended and a new charge cycle will not start until the temperature has come down to 50°C.

The Site Master is also equipped with an automatic charging process that changes the charging level based on the battery capacity. If the battery has been completely discharged to zero volts, a pre-charge at a low DC current will be applied until the battery reaches a level which is safe for a faster charge cycle. Similarly, the charging level will change when the battery is close to fully charged. This charging process helps maximize the number of recharge cycles available from the battery.

It is normal for NiMH batteries to self-discharge during storage (Figure 2-9) and to degrade to 80% of original capacity after 12 months of continuous use.

Figure 2-9. NiMH Battery Storage Characteristics

The battery can be charged and discharged 300 to 500 times, but it will eventually wear out. The battery may need to be replaced when the operating time between charging is noticeably shorter than normal.
Important Battery Information

- The NiMH battery supplied with the Site Master has already completed three charge and discharge cycles at the factory and full battery performance should be realized after the first charge.
- Recharge the battery only in the Site Master, or in an Anritsu approved charger.
- If left unused, a fully charged battery will discharge itself over time.
- Storing the battery in extreme hot or cold places will reduce the capacity and lifetime of the battery. The battery will discharge faster at higher ambient temperatures (see Figure 2-9).
- Discharge an NiMH battery from time to time to improve battery performance and battery life.
- The battery can be charged and discharged hundreds of times, but it will eventually wear out.
- The battery may need to be replaced when the operating time between charging is noticeably shorter than normal.
- If a battery is allowed to totally discharge, the smart-memory capability of the battery may be lost, resulting in incorrect battery capacity readings or loss of communication with the battery.
- Do not short-circuit the battery terminals.
- Do not drop, mutilate or attempt to disassemble the battery.
- Never use a damaged or worn out charger or battery.
- Always use the battery for its intended purpose only.
- Temperature extremes will affect the ability of the battery to charge. Allow the battery to cool down or warm up as necessary before use or charging.
- Battery storage is recommended at less than 45°C.
- Batteries must be recycled or disposed of properly. Do not place batteries in the trash.
- Do not dispose of batteries in a fire!
Chapter 3
Getting Started

Introduction

This chapter provides a brief overview of the Anritsu Site Master. The intent of this chapter is to provide the user with a starting point for making basic cable and antenna analyzer measurements.

Power On Procedure

The Anritsu Site Master is capable of up to 1.5 hours of continuous operation from a fully charged, field-replaceable battery. Built-in energy conservation features allow battery life to be extended.

The Site Master can also be operated from an external DC source (which will also simultaneously charge the battery). This can be achieved with either the Anritsu AC-DC Adapter (P/N 40-168-R) or the Automotive Cigarette Lighter Adapter (P/N 806-141). Both items are included as standard accessories (see Chapter 1).

To power on the Site Master:

**Step 1.** Press the ON/OFF front panel key (Figure 3-1).

**Step 2.** The Site Master will display the model number, the firmware revision, the internal temperature and voltage, and then perform a five second self test. At completion of the self-test, the screen displays a prompt to press ENTER to continue. If enter is not pressed, the Site Master will continue after a five second timeout.

**Step 3.** Press ENTER to continue.

The Site Master is now ready for operation.


Cable and Antenna Analyzer Mode

Selecting the Frequency

For the OSL or FlexCal calibration method the frequency range for the desired measurement must be set. The Site Master will automatically set the frequency when a particular signal standard is selected, or the frequency can be manually set using the F1 and F2 soft keys.

To set the frequency to a specific signal standard for an OSL or FlexCal calibration:

Step 1. Press the FREQ/DIST key.
Step 2. Press the Signal Standard soft key.
Step 3. Use the Up/Down arrow key to highlight the desired standard, then press the ENTER key to select.

To manually select the frequency range for an OSL or FlexCal calibration:

Step 1. Press the FREQ/DIST key.
Step 2. Press the F1 soft key.
Step 3. Enter the desired start frequency using the keypad or the Up/Down arrow key.
Step 4. Press ENTER to set F1 to the desired frequency.
Step 5. Press the F2 soft key.
Step 6. Enter the desired stop frequency using the keypad or the Up/Down arrow key.
Step 7. Press ENTER to set F2 to the desired frequency.
Step 8. Check that the start and stop frequencies displayed match the desired measurement range.

Calibration

Calibration Methods

For accurate results, the Site Master must be calibrated before making any measurements. The Site Master must be re-calibrated whenever the setup frequency changes, the temperature exceeds the calibration temperature range or when the test port extension cable is removed or replaced.

The two methods of calibrating the Site Master, FlexCal and OSL calibration, can each be accomplished with either discrete components or with the InstaCal Module, providing four calibration techniques for maximum user flexibility. FlexCal is a broadband frequency calibration that remains valid if the frequency is changed. An OSL calibration is an Open, Short and Load calibration for a selected frequency range, and is no longer valid if the frequency is changed. The default calibration mode is OSL.

With either calibration method, the Site Master may be calibrated manually with Open, Short, Load (OSL) calibration components, or by using the InstaCal module.
If a Test Port Extension Cable is to be used, the Site Master must be calibrated with the Test Port Extension Cable in place. The Test Port Extension Cable is a phase stable cable and is used as an extension cable on the test port to ensure accurate and repeatable measurements. This phase stable cable can be moved and bent while making a measurement without causing errors in the measurement.

**NOTE:** The test port extension cable should have the appropriate connectors for the measurement. Use of additional connector adapters after the test port extension cable can contribute to measurement errors not compensated for during calibration.

**Calibration Verification**

During the calibration process in Return Loss mode, either with discrete calibration components or with the InstaCal module, there are typical measurement levels expected. Verifying the measurement levels displayed on the screen during calibration can save valuable time in the field.

**Trace Characteristics in Return Loss Mode**

As the discrete calibration components are connected to the Site Master RF out port, the following measurement levels will be displayed on the screen:

- When an OPEN is connected, a trace will be displayed between 0-10 dB.
- When a SHORT is connected, a trace will be displayed between 0-10 dB.
- When a LOAD is connected, a trace will be displayed between 0-50 dB.

When an InstaCal module is connected to the Site Master RF out port, the following measurement levels will be displayed on the screen:

- When the Site Master is measuring an equivalent OPEN, a trace will be displayed between 0-20 dB.
- When the Site Master is measuring an equivalent SHORT, a trace will be displayed between 0-20 dB.
- When the Site Master is measuring an equivalent LOAD, a trace will be displayed between 0-50 dB.

The following procedures explain standard OSL, FlexCal, and InstaCal calibration methods. Refer to Figure 3-2 for a calibration setup diagram.
OSL Calibration Procedures

In Cable and Antenna Analyzer Mode, if the Cal Off message is displayed, or the test port cable has been changed, a new calibration is required. The following procedures detail how to perform the OSL calibration.

Standard OSL Calibration

Step 1. Select OSL Cal by pressing the SYS key, followed by the Application Options soft key. The currently selected calibration method is indicated at the bottom of the status window. Use the CAL Mode soft key to select the OSL calibration method.

Step 2. Select the appropriate frequency range, as described on page 3-2.

Step 3. Press the START CAL key. The message “Connect OPEN or INSTACAL module to RF Out Port” will appear in a message box, with the calibration type in the message box title bar.

Step 4. Connect the calibrated Open and press the ENTER key. The messages “Measuring OPEN” and “Connect SHORT to RF Out” will appear.

Step 5. Remove the Open, connect the calibrated Short and press the ENTER key. The messages “Measuring SHORT” and “Connect LOAD to RF Out” will appear.

Step 6. Remove the Short, connect the calibrated Termination and press the ENTER key. The message “Measuring LOAD” will appear. An audible tone will sound when the calibration is complete.

Step 7. Verify that the calibration has been properly performed by checking that the Cal ON message is now displayed in the upper left corner of the display.
**FlexCal OSL Calibration**

**Step 8.** The currently selected calibration method can be viewed by pressing the SYS key, followed by the Status soft key. To change the calibration method, select the SYS key, followed by the Application Options soft key. Use the CAL Mode soft key to select the FlexCal calibration mode.

**Step 9.** Press the START CAL key. The message “Connect OPEN or INSTACAL module to RF Out Port” will appear in a message box, with the calibration type in the message box title bar.

**Step 10.** Connect the calibrated Open and press the ENTER key. The messages “Measuring OPEN” and “Connect SHORT to RF Out” will appear and the frequency is automatically set by the Site Master from 25 MHz to 4000 MHz.

**Step 11.** Remove the Open, connect the calibrated Short and press the ENTER key. The messages “Measuring SHORT” and “Connect LOAD to RF Out” will appear.

**Step 12.** Remove the Short, connect the calibrated Termination and press the ENTER key. The message “Measuring LOAD” will appear. An audible tone will sound when the calibration is complete.

**Step 13.** Verify that the calibration has been properly performed by checking that the FlexCal ON message is now displayed in the upper left corner of the LCD.

**InstaCal Module Verification**

Verifying the InstaCal module before any line sweeping measurements is critical to the measured data. InstaCal module verification identifies any failures in the module due to circuitry damage or failure of the control circuitry. This test does not attempt to characterize the InstaCal module, which is performed at the factory or the service center.

The performance of the InstaCal module can be verified by the Termination method or the Offset method. The termination method is the preferred method in the field, and is similar to testing a bad load against a known good load.

**Termination Method**

The Termination method compares a precision load against the InstaCal module and provides a baseline for other field measurements. A precision load provides better than 42 dB directivity.

**Step 1.** Set the frequency according to the device under test (cellular, PCS, GSM).

**Step 2.** Press the MODE key and select Freq-Return Loss mode.

**Step 3.** Connect the InstaCal module to the Site Master RF Out port and calibrate the Site Master using the InstaCal module (page 3-6).

**Step 4.** Remove the InstaCal module from the RF Out port and connect the precision load to the RF Out port.

**Step 5.** Measure the return loss of the precision load. The level should be less than 35 dB across the calibrated frequency range.

**Step 6.** Press the MARKER key and set the M1 marker to Marker To Peak. The M1 value should be less than 35 dB return loss.

**Step 7.** Press SAVE DISPLAY (page 3-10) name the trace, and press ENTER.
Offset Method

An alternative to the termination method is to measure the return loss of a 20 dB offset. This is similar to measuring an antenna that has been specified to have a 20 dB return loss across the frequency of operation. A 20 dB offset provides a 20 dB return loss across a very wide frequency range. Measuring the return loss with the 20 dB offset will provide a relatively flat response across the operating frequency range of the Site Master.

Step 1. Set the frequency according to the device under test (cellular, PCS, GSM).

Step 2. Press the MODE key and select Freq-Return Loss mode.

Step 3. Connect the InstaCal module to the Site Master RF Out port and calibrate the Site Master using the InstaCal module (page 3-6).

Step 4. Remove the InstaCal module from the RF Out port and connect the 20 dB Offset to the RF Out port.

Step 5. Measure the return loss of the 20 dB Offset. The level should be 20 dB, ±2 dB across the calibrated frequency range.

Step 6. Press the MARKER key and set the M1 marker to Marker To Peak. The M1 value should be approximately 20 dB return loss.

Step 7. Press SAVE DISPLAY (page 3-10) name the trace, and press ENTER.

InstaCal Module Calibration Procedures

NOTE: The InstaCal module is not a discrete calibration component and it can not be used at the top of the tower to perform line sweep measurements.

Check that the CAL Off message is displayed in the upper left corner of the status window. This indicates that the Site Master has not been calibrated. The following procedures detail how to perform a calibration using the InstaCal module.

Figure 3-3. InstaCal Module Calibration
Standard InstaCal Calibration

**Step 1.** Select OSL Cal by pressing the **SYS** key, followed by the Application Options soft key. The currently selected calibration method is indicated at the bottom of the status window. Use the CAL Mode soft key to select the OSL calibration method.

**Step 2.** Select the appropriate frequency range, as described on page 3-2.

**Step 3.** Press the **START CAL** key. The message “Connect OPEN or InstaCal to RF Out port” will appear in a message box, with the calibration type in the message box title bar.

**Step 4.** Connect the InstaCal module to the RF Out port (Figure 3-3).

**Step 5.** Press the **ENTER** key. The Site Master senses the InstaCal module and automatically calibrates the unit using the OSL procedure. The calibration should take about 45 seconds. An audible tone will sound when the calibration is complete.

**Step 6.** Verify that the calibration has been properly performed by checking that the Cal On! message is displayed in the upper left corner of the status window.

FlexCal InstaCal Calibration

**Step 1.** Select FlexCal by pressing the **SYS** key, followed by the Application Options soft key. The currently selected calibration method is indicated at the bottom of the status window. Use the CAL Mode soft key to select the FlexCal calibration method.

**Step 2.** Press the **START CAL** key. The message “Connect OPEN or InstaCal to RF Out port” will appear in a message box, with the calibration type in the message box title bar.

**Step 3.** Connect the InstaCal module to the RF Out port (Figure 3-3). The Site Master automatically sets the frequency from 25 MHz to 4000 MHz.

**Step 4.** Press the **ENTER** key. The Site Master senses the InstaCal module and automatically calibrates the unit using the OSL procedure. The calibration should take about 45 seconds. An audible tone will sound when the calibration is complete.

**Step 5.** Verify that the calibration has been properly performed by checking that the FlexCal On! message is displayed in the upper left corner of the status window.

Calibration with the Test Port Extension Cable

If a Test Port Extension Cable is to be used, the Site Master must be calibrated with the Test Port Extension Cable in place. Follow the same calibration procedures as above with the OSL components or the InstaCal module in place at the end of the test port extension cable.
Auto Scale

The Site Master can automatically set the scale to the minimum and maximum values of the measurement on the y-axis of the graph. This function is particularly useful for measurements in SWR mode. To automatically set the scale, press the AUTO SCALE key. The Site Master will automatically set the top and bottom scales to the minimum and maximum values of the measurement with some margin on the y-axis of the LCD.

Amplitude Scale

The following procedure sets the top and bottom scale display.

**Step 1.** Press the AMPLITUDE key to call up the Scale Menu.

**Step 2.** Press the Top soft key and use the keypad or Up/Down arrow key to edit the top scale value. Press ENTER to set.

**Step 3.** Press the Bottom soft key and use the keypad or Up/Down arrow key to edit the bottom scale value. Press ENTER to set.

*NOTE:* Typically the y-axis scale of the graph is 0-60 dB (return loss) but for some measurements (for example, insertion loss) the scale may be changed to 0-10 dB. If the scale is not changed, some measurement results may not be easily viewed on the screen.

Set the Distance and Cable Type

In Distance-To-Fault (DTF) mode, the length of the transmission line (distance) and cable type are selected. The cable type determines the velocity propagation and cable attenuation factor. The following procedure can be used to set the distance and select the appropriate cable type.

*NOTE:* Selecting the correct cable is very important for accurate measurements and for identifying faults in the transmission line. Selecting the incorrect cable, or using the correct cable out of its proper frequency characteristics type, will shift the DTF trace vertically and horizontally making it difficult to accurately locate faults.

**Step 1.** Press the MODE key.

**Step 2.** Select DTF Return Loss or DTF SWR mode. The Site Master automatically sets D1 to zero.

**Step 3.** Press the D2 soft key.

**Step 4.** Enter the appropriate D2 value for the maximum length of the transmission line and press the ENTER key to set the D2 value.

**Step 5.** Press the DTF Aid soft key.
Step 6. Using the Up/Down arrow key, select the Cable = and press ENTER. Use the Up/Down arrow key to select the Standard cable types stored in the standard Site Master cable lists (which cannot be edited) or choose Custom, for additional cables. A custom cable list can be created and uploaded using the Handheld Software Tools application provided with the Site Master (Chapter 10).

Step 7. Using the Up/Down arrow key, select the appropriate type of cable and press the ENTER key. The selected cable type, Prop Vel and Cable Loss in dB/m (or dB/ft) will be displayed on the DTF parameters screen.

Step 8. Press ENTER.
All Modes

Save and Recall a Setup

Saving a Setup

Saving a cable and antenna analyzer setup configuration in memory will preserve the calibration information.

Step 1. To save the configuration in one of the available user setup locations, press SAVE SETUP. There are ten locations in cable and antenna analyzer modes.

Step 2. Use the key pad or the Up/Down arrow key to select a location.

Step 3. Press ENTER to save the setup.

**NOTE:** For cable and antenna analyzer modes, an OSL calibration is saved with an OSL designation, an InstaCal OSL calibration is saved with an OSL!, a FlexCal OSL calibration is saved with an FLX, and an InstaCal FlexCal calibration is saved with an FLX!

Recalling a Setup

The following procedure recalls a setup from memory.

Step 1. Press the RECALL SETUP key.

Step 2. Select the desired setup using the Up/Down arrow key.

Step 3. Press ENTER to recall the setup.

**NOTE:** Only setups from the current mode are displayed.

Save and Recall a Display

Saving a Display

The following procedure saves a display to memory.

Step 1. Press the SAVE DISPLAY key to activate the alphanumeric menu for trace storage.

Step 2. Use the soft keys to enter a label for the saved trace.

For example, to save a display with the name “TX1 RETURN LOSS” press the soft key group that contains the letter “T” then press the “T” soft key. Press the soft key group that contains the letter “X” then press the “X” soft key. Press the number “1” key on the numeric keypad. Use the soft keys and keypad as necessary to enter the entire name, then press ENTER to complete the process.
NOTES: More than one trace can be saved using the same alphanumeric name, as traces are stored chronologically, using the time/date stamp.

Pressing the **SAVE DISPLAY** key will bring up the last saved trace name on the input line. Pressing the Delete soft key will erase the entire trace name. To erase only one character of a trace name, press the Up/Down arrow key to select the character, then press the Delete soft key. This feature can be useful when naming traces sequentially, such as: Trace 1, Trace 2, etc.

Recalling a Display

The following procedure recalls a previously saved display from memory.

**Step 1.** Press the **RECALL DISPLAY** key.

**Step 2.** Select the desired display using the Up/Down arrow key.

**Step 3.** Press **ENTER** to recall the display.

Changing the Units

By default, the Site Master displays information in metric units. Use the following procedure to change the display to English units when in cable and antenna analyzer mode.

**Step 1.** Press the **SYS** key.

**Step 2.** Select the **System Options** soft key.

**Step 3.** Press the **Units** soft key to change from metric to English measurement units, or vice versa. The current selection is displayed at the bottom left corner of the screen.

Changing the Language

By default, the Site Master displays messages in English. To change the display language:

**Step 1.** Press the **SYS** key.

**Step 2.** Select the **Language** soft key.

**Step 3.** Select the desired language. Choices are English, French, German, Spanish, Chinese, and Japanese. The default language is English.

Adjusting Markers

**Step 1.** Press the **MARKER** key to call up the Markers menu.

**Step 2.** Press the M1 soft key to select the M1 marker function.

**Step 3.** Press the **Edit** soft key and enter an appropriate value using the keypad or Up/Down arrow key to move the marker without redrawing the trace. Pressing the **ON/OFF** soft key activates or deactivates the M1 marker function.

**Step 4.** Press the Back soft key to return to the Markers Menu.

**Step 5.** Repeat the steps for markers M2, M3, M4, M5 and M6.
Adjusting Limits

The Site Master offers two types of limits: a single horizontal limit line and segmented limits.

**Adjusting a Single Limit**

- **Step 1.** Press the LIMIT key.
- **Step 2.** Press the Single Limit soft key.
- **Step 3.** Press the Edit soft key.
- **Step 4.** Either enter the value using the numeric keypad or scroll the limit line using the Up/Down arrow key.
- **Step 5.** Press ENTER to set the location of the limit line.

**Adjusting Segmented Limits**

Segmented limit lines are defined separately as five upper limit segments and five lower limit segments. This allows the definition of a spectral mask.

A limit segment is defined by its end points. That is, starting frequency, starting amplitude, ending frequency, and ending amplitude. This procedure describes the setting of two upper limit segments. The steps can be carried over to the other upper limit segments as well as to the lower limit segments.

- **Step 1.** Press the LIMIT key.
- **Step 2.** Press the Multiple Upper Limits soft key.
- **Step 3.** Press the Segment 1 soft key.
- **Step 4.** Press the Edit soft key. The status window will successively display the value of the segment endpoints: Start Freq, Start Limit, End Freq, End Limit.
- **Step 5.** Edit each value using the numeric keypad or scroll the limit line using the Up/Down arrow key and press ENTER to set.
- **Step 6.** Press the Next Segment soft key to move on to Segment 2. If the status of Segment 2 is OFF, pressing the Next Segment soft key will automatically set the start point of segment 2 equal to the end point of Segment 1.
- **Step 7.** Repeat these steps for the remaining segments.
- **Step 8.** When the final segment is defined, press the Back soft key to end the editing process.
### NOTES

The Site Master does not allow overlapping limit segments of the same type. That is, two upper limit segments cannot overlap and two lower limit segments cannot overlap.

The Site Master also does not allow vertical limit segments. A limit segment in which the start and end frequencies are the same, but the limit values are different, cannot be specified.

---

**Enabling the Limit Beep**

Both limit types can indicate a limit violation by enabling the Limit Beep. An audible "beep" will sound at each data point that violates the defined limit.

- **Step 1.** Press the **LIMIT** key (numeric keypad number 7).
- **Step 2.** Press the Limit Beep soft key. The status window will indicate that the status of the limit beep is On, and the soft key will remain in the "down" state. Press the Limit Beep soft key again to disable the limit beep.

---

**Adjusting the Display Brightness**

The brightness of the display can be adjusted to accommodate varying light conditions and to help discern traces.

- **Step 1.** Press the light bulb key (numeric keypad number 1).
- **Step 2.** Adjust the brightness using the Up/Down arrow key.
- **Step 3.** Press **ENTER** to save the new setting.
Printing

Printing is accomplished by selecting an available printer and pressing the print key as described below. Refer to the particular printer operating manual for specific printer settings.

Printing a Screen

Step 1. Obtain the desired measurement display.
Step 2. Press the SYS key and the System Options soft key.
Step 3. Press the Printer soft key and select from the displayed menu of supported printers.
Step 4. Press the PRINT key.
Step 5. Connect the printer as shown in Figure 3-4.

Printer Switch Settings

Set the switches on the serial-to-parallel interface cable to the HP Deskjet 450 ink jet printer as follows:

<table>
<thead>
<tr>
<th>SW1</th>
<th>SW2</th>
<th>SW3</th>
<th>SW4</th>
<th>SW5</th>
<th>SW6</th>
<th>SW7</th>
<th>SW8</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF</td>
<td>ON</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>ON</td>
<td>OFF</td>
</tr>
</tbody>
</table>
Using the Soft Carrying Case

The soft carrying case has been designed such that the strap can be unsnapped to allow the case to be easily oriented horizontally; thus allowing the Anritsu controls to be more easily accessed (Figure 3-5).

Figure 3-5. Using the Site Master Soft Carrying Case
Chapter 4  
Cable and Antenna Analyzer Measurements

Introduction

This chapter provides a description of cable and antenna analyzer measurements, including line sweeping fundamentals and line sweeping measurement procedures, available when the Site Master is in frequency or DTF mode.

Line Sweep Fundamentals

In wireless communication, the transmit and receive antennas are connected to the radio through a transmission line. This transmission line is usually a coaxial cable or waveguide. This connection system is referred to as a transmission feed line system. Figure 4-1 shows an example of a typical transmission feed line system.
The performance of a transmission feed line system may be affected by excessive signal reflection and cable loss. Signal reflection occurs when the RF signal reflects back due to an impedance mismatch or change in impedance caused by excessive kinking or bending of the transmission line. Cable loss is caused by attenuation of the signal as it passes through the transmission line and connectors.

To verify the performance of the transmission feed line system and analyze these problems, three types of line sweeps are required:

**Return Loss Measurement**—Measures the reflected power of the system in decibels (dB). This measurement can also be taken in the Standing Wave Ratio (SWR) mode, which is the ratio of the transmitted power to the reflected power.

**Cable Loss Measurement**—Measures the energy absorbed, or lost, by the transmission line in dB/meter or dB/ft. Different transmission lines have different losses, and the loss is frequency and distance specific. The higher the frequency or longer the distance, the greater the loss.

**Distance-To-Fault (DTF) Measurement**—Reveals the precise fault location of components in the transmission line system. This test helps to identify specific problems in the system, such as connector transitions, jumpers, kinks in the cable or moisture intrusion.

The different measurements are defined as:

**Return Loss - System Sweep**—A measurement made when the antenna is connected at the end of the transmission line. This measurement provides an analysis of how the various components of the system are interacting and provides an aggregate return loss of the entire system.

**Distance To Fault - Load Sweep**—A measurement is made with the antenna disconnected and replaced with a 50Ω precision load at the end of the transmission line. This measurement allows analysis of the various components of the transmission feed line system in the DTF mode.

**Cable Loss Sweep**—A measurement made when a short is connected at the end of the transmission line. This condition allows analysis of the signal loss through the transmission line and identifies the problems in the system. High insertion loss in the feed line or jumpers can contribute to poor system performance and loss of coverage.

This whole process of measurements and testing the transmission line system is called Line Sweeping.
**CW Mode/RF Immunity**

CW mode can be used to maximize sweep speeds of both frequency and DTF measurements. With CW on, sweep times can be twice as fast as with CW off. However, making measurements with CW on will reduce the instrument’s immunity to interfering signals. In a controlled environment, this reduced immunity should not be a problem. In the field however, there can be stray signals from nearby or co-located transmitters that can affect frequency and DTF measurements. Turning CW on and off can verify that the Site Master is reducing the interfering signals. If there is no appreciable difference, then it should be safe to make measurements with CW on.

Use this feature with caution, as the later introduction of an interfering signal might be mistaken for a problem with the antenna or cable run.

If CW is on during a normal RL or SWR measurement, the Site Master will be more susceptible to interfering signals. Interfering signals can make the measurement look better or worse than it really is.

**Information Required for a Line Sweep**

The following information must be determined before attempting a line sweep measurement:

- System Frequency Range, to set the sweep frequency
- Cable Type, to set the cable characteristics for DTF measurements
- Distance of the Cable Run, to set the distance for DTF measurements

**Typical Line Sweep Test Procedures**

This section provides typical line sweep measurements used to analyze the performance of a transmission feed line system.

**System Return Loss Measurement**

System return loss measurement verifies the performance of the transmission feed line system with the antenna connected at the end of the transmission line. To measure the system return loss:

**Required Equipment**

- Site Master Model S331D
- Precision Open/Short, Anritsu 22N50 or Precision Open/Short/Load, Anritsu OSLN50-1 or InstaCal Module ICN50B
- Precision Load, Anritsu SM/PL-1
- Test Port Extension Cable, Anritsu 15RNFN50-1.5-R
- Optional 510-90 Adapter, DC to 7.5 GHz, 50 ohm, 7/16(F)-N(M)

**Device Under Test**

- Transmission Feed Line with Antenna
Chapter 4 Cable & Antenna Measurements

Procedure

Step 1. Press the MODE key.

Step 2. Select Freq-Return Loss using the Up/Down arrow key and press ENTER.

Step 3. Set the start and stop frequencies, automatically by selecting a signal standard or manually using the F1 and F2 soft keys, as described on page 3-2.

Step 4. Calibrate the Site Master as described on page 3-2.

Step 5. Connect the Device Under Test to the Site Master. A trace will be displayed on the screen when the Site Master is in the sweep mode.

Step 6. Press SAVE DISPLAY (page 3-10) name the trace, and press ENTER.

NOTE: The antenna must be connected at the end of the transmission feed line when conducting a System Return Loss measurement.

Figure 4-2 is an example of a typical system return loss measurement trace using a FlexCal calibration:

NOTE: The system sweep trace should appear at an approximate return loss of 15 dB (±3 dB) in the status window. Typically, greater than a 15 dB return loss is measured in the passband of the antenna system.
Cable Loss Measurement

The transmission feed line insertion loss test verifies the signal attenuation level of the cable system in reference to the specification. This test can be conducted with the Site Master in Freq–Cable Loss mode.

Required Equipment

- Site Master Model S331D
- Precision Open/Short, Anritsu 22N50 or
  Precision Open/Short/Load, Anritsu OSLN50-1 or
  Anritsu InstaCal Module, ICN50B
- Precision Load, Anritsu SM/PL-1
- Test Port Extension Cable, Anritsu 15RNFN50-1.5-R
- Optional 510-90 Adapter, DC to 7.5 GHz, 50 ohm, 7/16(F)-N(M)

Device Under Test

- Transmission Feed Line with Short

Procedure - Cable Loss Mode

Step 1. Press the MODE key.

Step 2. Select Freq-Cable Loss using the Up/Down arrow key and press ENTER.

Step 3. Set the start and stop frequencies, automatically by selecting a signal standard or manually using the F1 and F2 soft keys, as described on page 3-2.

Step 4. Connect the Test Port Extension cable to the RF port and calibrate the Site Master as described on page 3-2.

Step 5. Save the calibration set up (page 3-10).

Step 6. Connect the Device Under Test to the Site Master phase stable Test Port Extension cable. A trace will be displayed on the screen as long as the Site Master is in sweep mode.

Step 7. Cable loss is displayed in the status window.

Step 8. Press SAVE DISPLAY (page 3-10) name the trace, and press ENTER.
Figure 4-3 is an example of a typical transmission line cable loss measurement trace using a standard calibration.
Distance-To-Fault (DTF) Transmission Line Test

The Distance-To-Fault transmission line test verifies the performance of the transmission line assembly and its components and identifies the fault locations in the transmission line system. This test determines the return loss value of each connector pair, cable component and cable to identify the problem location. This test can be performed in the DTF–Return Loss or DTF–SWR mode. Typically, for field applications, the DTF–Return Loss mode is used. To perform this test, disconnect the antenna and connect the load at the end of the transmission line.

Required Equipment

- Site Master Model S331D
- Precision Open/Short, Anritsu 22N50 or
  Precision Open/Short/Load, Anritsu OSLN50-1 or
  Anritsu InstaCal Module, ICN50B
- Precision Load, Anritsu SM/PL-1
- Test Port Extension Cable, Anritsu 15RNFN50-1.5-R
- Optional 510-90 Adapter, DC to 7.5 GHz, 50 ohm, 7/16(F)-N(M)

Device Under Test

- Transmission Feed Line with Load

Procedure - DTF - Return Loss Mode

The following steps explain how to make a DTF measurement in return loss mode.

Step 1. Press the MODE key.

Step 2. Select DTF-Return Loss using the Up/Down arrow key and press ENTER.

Step 3. Connect the Test Port Extension cable to the RF port and calibrate the Site Master as described on page 3-2.

Step 4. Save the calibration set up (page 3-10).

Step 5. Connect the Device Under Test to the Site Master phase stable Test Port Extension cable. A trace will be displayed on the screen as long as the Site Master is in sweep mode.

Step 6. Press the FREQ/DIST key.

Step 7. Set the D1 and D2 values. The Site Master default for D1 is zero.

Step 8. Press the DTF Aid soft key and select the appropriate Cable Type to set the correct propagation velocity and attenuation factor.

NOTE: Selecting the right propagation velocity, attenuation factor and distance is very important for accurate measurements, otherwise the faults can not be identified accurately.

Step 9. Press SAVE DISPLAY (page 3-10) name the trace, and press ENTER.

Step 10. Record the connector transitions.
Figure 4-4 shows an example of a typical DTF return loss measurement trace using a FlexCal calibration.

In the above example:
- Marker M1 marks the first connector, the end of the Site Master phase stable Test Port Extension cable.
- Marker M2 marks the first jumper cable.
- Marker M3 marks the end of the main feeder cable.
- Marker M4 is the load at the end of the entire transmission line.

**Procedure - DTF-SWR Mode**

The following steps explain how to measure DTF in SWR mode.

**Step 1.** Press the MODE key.

**Step 2.** Select the DTF-SWR using the Up/Down arrow key and press ENTER.

**Step 3.** Follow the same procedure as DTF-Return Loss mode, above.

**Resolution**

There are three sets of data points (130, 259 and 517) available in the Site Master. The factory default is 259 data points. By increasing the number of data points the measurement accuracy and transmission line distance to measure will increase.

$$\text{Step size} = \frac{15 \times 10^8 (V_p)}{\Delta F}$$

Where $V_p$ is the relative propagation velocity of the cable and $\Delta F$ is the stop frequency minus the start frequency (Hz).

The maximum distance is: $D_{\text{max}} = \text{step size} \times (# \text{ of datapoints} - 1)$
Increasing the data points increases the sweep time and increases the accuracy of the measurement. CW mode On or Off can also affect sweep speed (see CW Mode, page 4-3 for details).

**Antenna Subsystem Return Loss Test**

Antenna Subsystem return loss measurement verifies the performance of the transmit and receive antennas. This measurement can be used to analyze the performance of the antenna before installation. The antenna can be tested for the entire frequency band, or tested to a specific frequency range. Transmit and receive frequency measurements are conducted separately. The following steps explain how to measure the antenna loss in return loss mode.

**Required Equipment**

- Site Master Model S331D
- Precision Open/Short, Anritsu 22N50 or Precision Open/Short/Load, Anritsu OSLN50-1 or Anritsu InstaCal Module, ICN50B
- Precision Load, Anritsu SM/PL-1
- Test Port Extension Cable, Anritsu 15RNFN50-1.5-R
- Optional 510-90 Adapter, DC to 7.5 GHz, 50 ohm, 7/16(F)-N(M)

**Device Under Test**

- Antenna Sub Assembly

**Procedure**

**Step 1.** Press the **MODE** key.

**Step 2.** Select **Freq-Return Loss** using the Up/Down arrow key and press **ENTER**.

**Step 3.** Connect the Test Port Extension cable to the RF port and calibrate the Site Master as described on page 3-2.

**Step 4.** Press **SAVE SETUP** and save the calibration set up (page 3-10).

**Step 5.** Connect the Device Under Test to the Site Master phase stable Test Port Extension cable.

**Step 6.** Press the **MARKER** key.

**Step 7.** Set markers M1 and M2 to the desired frequencies.

**Step 8.** Record the lowest return loss over the specified frequency range.

**Step 9.** Press **SAVE DISPLAY** (page 3-10) name the trace, and press **ENTER**.
The following trace is an example of an antenna return loss measurement trace using a FlexCal calibration.

Calculate the threshold value and compare the recorded Lowest Return Loss to the calculated threshold value.

Maximum Return Loss = \(-20 \log\left(\frac{VSWR - 1}{VSWR + 1}\right)\)

**NOTES:**

- VSWR is the antenna manufacturer’s specified VSWR.
- Use Handheld Software Tools to convert VSWR to Return Loss, or Return Loss to VSWR.

If the measured return loss is less than the calculated threshold value, the test fails and the antenna must be replaced.

**Figure 4-5. Antenna Return Loss Trace**
Chapter 5
Power Monitor Mode

Introduction

The Site Master with Option 5 installed can be used for making power measurements with broadband RF detectors, such as the 10 MHz to 20 GHz Anritsu 560-7N50B. See the table of available RF detectors on page 1-3. The power monitor displays the measured power results in dBm or Watts.

Power Measurement

Required Equipment

- Site Master Model S331D with Power Monitor option
- Broadband RF detector, Anritsu P/N 5400-71N50
- 30 dB, 50 Watt, bi-directional, DC –18 GHz, N(m) – N(f), Attenuator, 42N50A-30

Procedure

Step 1. Press the ON/OFF key on the Site Master.
Step 2. Press the MODE key.
Step 3. Use the Up/Down arrow key to select the Power Monitor mode and press ENTER.

Zeroing the Power Monitor

Step 4. With no power applied to the DUT, press the ZERO soft key from the Power menu. Wait for a few seconds while the Site Master accumulates data samples of the quiescent power. When complete, ZERO ADJ: On is displayed in the message area.

Measuring High Input Power Levels

Step 5. Insert an attenuator between the DUT and the RF detector to protect the Site Master so that the input power level is less than or equal to 20 dBm.
Step 6. Press the OFFSET soft key.
Step 7. Enter the attenuation in dB using the keypad. Press the ENTER key to complete the entry. The message area will show REL: ON along with the entered value in dB.

Displaying Power in dBm and Watts

Step 8. Press the UNITS soft key to display power in Watts.
Displaying Relative Power

**Step 9.** With the desired base power level input to the Site Master, press the REL soft key. The message area will show REL: ON and the power reading will indicate 100%.

**Step 10.** Press the UNITS soft key to display power in dBm. Since REL is ON, the power reading will be in dBr, relative to the base power level.
Chapter 6  
High Accuracy Power Meter

Introduction

Anritsu's High Accuracy Power Meter (Option 19) enables high accuracy, RMS measurements for both CW and digitally modulated signals such as CDMA/EV-DO, GSM/EDGE, and WCDMA/HSDPA. This option requires either the PSN50 or MA24104A power sensors. The PSN50 power sensor provides high accuracy terminating measurements from 50 MHz to 6 GHz with a dynamic range from –30 dBm to +20 dBm. The MA24104A is an Inline High Power sensor with a frequency range from 600 MHz to 4 GHz and can measure signals as high as 150W. Both of the power sensors are equipped with an RS232 interface for fast and easy connection to the Site Master.

Units and Relative Power

The display shows the power values in both dBm and Watts. The Relative Power feature displays power changes with respect to a reference value in both dB and %.

![High Accuracy Power Measurement Display](image)

Figure 6-1.  High Accuracy Power Measurement Display

Limit Lines

Limits can be used to determine if a measurement is within specified limits, and running averaging is available along with Max/Hold and Run/Hold.

Connecting the Sensor

The Option 19 High Accuracy Power Meter connects to the PSN50 or MA24104A power sensor using an RS232 cable (Anritsu part number 800-441). A 9 to 18 VDC (<100 mA) power supply is needed to power either sensor (the MA24104A power sensor can also be powered with three AA batteries). Anritsu power supply (40-168-R), supplied with the Site Master, is recommended.
Zeroing the Sensor

The zero feature improves low-level accuracy by removing measured system noise. Cal Factors correct both efficiency and mismatch loss. The frequency information must be entered to obtain the correct calibration factor.

Using Attenuators

When necessary, attenuators should be used to ensure that the power does not exceed the specified measurement range. The Offset dB feature can be used to enter the value of any cables and attenuators.

Power Measurement

Required Equipment

- S331D Site Master
- RS232 Serial Cable, Anritsu P/N 800-441
- Power Supply, Anritsu P/N 40-168-R
- PSN50 or MA24104A Power Sensor
- 30 dB, 50W, bi-directional, DC-8.5 GHz, N(m)-N(f), Attenuator, 3-1010-123

Procedure

Step 1. Connect the RS232 serial cable between the sensor and the Site Master serial port.

Step 2. Connect the DC power supply to the DC input of the PSN50 or MA24104A.

Step 3. Press the ON/OFF key on the Site Master.

Step 4. Press the MODE key.

Step 5. Use the Up/Down arrow key to select High Accuracy Power Meter mode and press ENTER.
Zero and Cal

Step 6. Press the **FREQ/DIST** key.

Step 7. To enter the frequency manually using the number keys, select the **Center** soft key. To select a known signal standard, press the **Signal Standard** soft key and use the Up/Down arrow key to select the desired standard. The Cal Factors will be derived for the corresponding center frequency.

**NOTE:** The channel number is not required because the cal factor frequencies are rounded to the nearest 500 MHz.

Step 8. With no power applied to the sensor, press the **AMPLITUDE** key then the **Zero** soft key to zero the sensor. Zeroing the sensor is recommended when making power measurements below –20 dBm.

Using Attenuators

Step 9. Press the **AMPLITUDE** key and select the **Offset dB** soft key.

Step 10. Connect the phase stable cable and the attenuator between the DUT and the sensor.

Step 11. Enter the combined offset value of the attenuator and the pad, or select the **Measure Offset** soft key to use the Offset Cal Kit (65701) to measure the offset. See page 6-5 for more details.

Averaging/Max Hold/Run Hold

Step 12. Press the **MEAS/DISP** key.

Step 13. Press the **Running Averages** soft key and use the keypad to enter the number of averages to use (up to 50).

Step 14. Press the **Max Hold** soft key to display the maximum value. If Averaging is selected, Max/Hold will display the maximum value of the non-averaged data.

Step 15. Press the **RUN/HOLD** key to hold the display in the current condition.

Setting Limits

Step 16. Press the **MEAS/DISP** key.

Step 17. Press the **Limit Units** soft key to select the units.

Step 18. Press the **Lower Limit** soft key and enter the lower limit value in dBm or in Watts.

Step 19. Press the **Upper Limit** soft key and enter the upper limit value in dBm or in Watts.

Step 20. Press the **Limit ON/OFF** soft key to turn on the limits. The number display will turn green if the measurement is passing, or red if the measurement is failing. The word **PASS** or **FAIL** will also be displayed in between the logarithmic and linear display windows.
Displaying Relative Power

Step 21. Press the **AMPLITUDE** key.

Step 22. With the desired base power level input to the sensor, press the **Rel** soft key. The message area will show **Relative On** and the power reading will show 0 dB and 100%. If measuring a 10 dBm signal with the **Rel** key selected, a drop to 7 dBm will show –3dB and 50%.

Saving the Measurement

Step 23. Press the **SAVE DISPLAY** key.

Step 24. Use the soft keys to enter a Trace Name.

Transferring Data to Handheld Software Tools

The Site Master has only one serial port, so it is not possible to communicate with both the PSN50 sensor and a PC running Handheld Software Tools (HHST) at the same time. Therefore, only saved measurements can be viewed in HHST when using the PSN50. To view saved measurements, disconnect the serial cable from the PSN50 and connect it to the serial port of the PC running HHST. Refer to the Handheld Software Tools chapter in this manual for further information.
Chapter 7
Handheld Software Tools

Introduction

This chapter provides a description of the Anritsu Handheld Software Tools (HHST) program. Handheld Software Tools is a Windows 95/98/NT4/2000/ME/XP/Vista program for transferring measured traces, along with markers and limit lines, to the PC display. The program help function provides on screen instructions on display modification, trace overlay, uploading and downloading traces, and multiple plot printing.

NOTE: Master Software Tools (MST) now works with the Site Master S331D. We strongly recommend users to migrate to MST. This platform has numerous productivity advantages over HHST and all future product enhancements will be done via MST. See Chapter 8 for more information on MST.

Features

Handheld Software Tools provides the following features:

- Download traces saved in the instrument memory to the PC for storage and analysis
- Upload traces from the PC to the instrument memory
- Trace Overlay allows the viewing of three plots simultaneously
- Ability to save captured plots as data files (.dat file format) or as records representing site information in a database file
- Ability to export plot data as text files for use in a spreadsheet (.txt file format)
- Ability to save captured plots as graphic files (.wmf file format)
- Ability to zoom in or out to analyze a particular region of the plot
- Ability to modify Plot Properties
- Ability to output plots to a printer for hard copy records
- Capture the current trace on the unit
- Create custom cables to be uploaded to the instrument
- Create new signal standards to be uploaded to the instrument
- Create new waveguides to be uploaded to the instrument
**System Requirements**

The Handheld Software Tools program will run on most any computer running Windows 95/98/NT4/2000/ME/XP/Vista. Minimum requirements and recommendations are:

- Intel Pentium 100 MHz microprocessor (Pentium II 350 MHz or better recommended)
- 16 MB of RAM (64 MB or above recommended)
- Hard disk drive with approximately 15 MB of available space (An additional 20 MB free space for storage of captured plots is recommended.)
- A serial (COM) port or a USB port and USB power adapter cable for communication with the instrument

**NOTE:** It is recommended that Windows NT 4.0 users install NT 4.0 Service Pack 3 (SP3) or above. In addition, Windows 2000 (SP1 or higher) and Windows ME may require installation of the latest Service Pack. Please contact Microsoft Corporation for further information on obtaining and installing service packs.

**Installation**

To install the Handheld Software Tools program:

**Step1.** Insert the Anritsu Handheld Software Tools disk in the CD-ROM drive.

**Step2.** From the Windows Start menu, select Run.

**Step3.** Type: `X:\Setup.exe` where X is the drive letter of your CD-ROM drive.

**Step4.** When prompted, press the Enter key to accept the default directory C:\Program Files\Software Tools and the installation will begin.

The `readme.doc` file on the disk provides updated information about the program, and the Help function provides detailed operating information.
Communication Port Setting

The Handheld Software Tools communicates with the instrument through a standard serial COM port on the PC. Set the baud rate of the COM port to 115200.

**Step1.** Select **Start, Programs** and select **Software Tools**.

**Step2.** When the program has loaded, select **Settings, Communication**.

**Step3.** Select the appropriate PC COM port and Transfer Baud Rate for your system, and click **OK**. (For the optional USB Adapter Cable (551-1691) set the COM port to COM 4, and the baud rate to 38400.)

---

*Figure 7-1. Communication Setting Dialog Box*
Interface Cable Installation

Communication between the instrument and the PC is accomplished over a null modem serial cable provided with the instrument (Anritsu part number 800-441, and optional USB to serial adapter, part number 551-1691, if required).

**Step1.** Install the null modem serial interface cable to the RS232 Serial Interface connector on the test connector panel.

**Step2.** Connect the other end of the serial interface cable to the appropriate COM port connector on the PC.

**Step3.** Turn on both the instrument and the PC.

---

![Serial Cable Connection](image)

*Figure 7-2. Serial Cable Connection*
Using Handheld Software Tools

Select Start, Programs and select Software Tools.

Downloading Traces

Traces that can be downloaded from the instrument are grouped by the date on which they were saved. They are further organized in chronological order for each date, with the oldest trace at the top of the list. Each trace listing displays the trace name and measurement type for that trace. Available measurement types are:

- Return Loss
- SWR
- Cable Loss
- DTF (Distance to Fault)
- Insertion Loss
- Insertion Gain
- Power Monitor

NOTE: Not all selections apply to every Anritsu Handheld instrument.

Plot Capture to the PC

To open the plot capture menus, select the capture icon on the button bar, or select the Capture drop down menu from the menu bar.

Select Capture to Screen to download traces to the PC.

Select a folder, or individual traces within a folder, to be downloaded to the PC. The traces will appear on the PC display as they are downloaded.

When Software Tools is communicating with the instrument, REMOTE will be displayed to the left of the graph.

Plot Upload to the Instrument

Open a plot to be uploaded to the instrument. Plot properties can be modified on the PC before it is uploaded if desired.

Select the Capture drop down menu from the menu bar.

Select Upload the Current Plot to upload the plot to the instrument. The plot will be stored in the instrument non-volatile memory with the original date and time that the plot was saved. The uploaded trace can be viewed on the instrument by pressing the RECALL DISPLAY button on the instrument keypad.
Plot Properties

After downloading, certain plot properties and information can be modified. Select the Plot Properties or Plot Information icon.

Plot Properties that can be changed include:
- Graph Titles
- Display Mode
- Scale/Limit
- Markers
- Misc. (Plot Display Parameters)

Graph Titles

After downloading the plot, the Main Title can be changed to reflect the site name or other descriptive information. The Sub Title field can be used to describe the specifics of the measurement and configuration.

Scale/Limit

The scale of the displayed plot can be modified to help analyze whether the plot meets pass/fail criteria. The Scale/Limit sub menu activates options to manually enter the scale limits, or to use the Auto Scale mode.

- **Manual** adjustment sets the upper and lower limits of the display under the Scale/Limit Submenu.
- **Auto Scale** automatically adjusts the scale for maximum and minimum measurement readings.
- **Limit Line Off** turns off all limit lines.
- **Single Limit Line** can be activated to help identify faults.
- **Multi-Segment Limit Lines** can be activated to set different limits within the same measurement display for specification requirements.

Markers

Markers M1 through M6 can be activated from the Plot Properties menu.

The six active markers can be displayed on the plot to help identify faults from the line sweep data.
Misc.

The Miscellaneous tab allows adjustment of the Plot/Limit Line Width, the setting of the Plot Footer, and the date format.

**Plot/Limit Line Width** can be used when preparing reports for the carrier, service providers, and network operators where the trace data must be visible and legible for documentation. The line density of the trace can be set to **Normal (Thin Line)** or **Thick Line** to make the data appear easily when copies are made.

**Plot Footer** allows selection of information to be displayed in the trace display. Selections are:

- Time/Date
- Model and Serial Number
- Bias Tee
- Date Format: mm/dd/yyyy
- dd/mm/yyyy
- yyyy/mm/dd

**NOTE:** While all possible selections are displayed, some of these selections apply only to specific models of Anritsu handheld instruments.

Trace Overlay or Plot Overlay

Trace Overlay is activated by the Mouse Function icon. Single-click on the Mouse Function icon to toggle. Toggling this icon switches the mouse function between Marker/Limit/Zoom and Plot Overlaying.

To overlay two plots, click-and-drag from one plot to the other plot. The final display will be the two plots superimposed on one another.

Refer to the Handheld Software Tools HELP function for more information on the steps necessary to perform a trace overlay.

Saving Traces

Once the plots are captured to the PC they can be saved as individual files or as a block of files to a database.

**Saving a Plot as a Windows Metafile or to a Spreadsheet**

Plots can be saved as a Windows metafile (.wmf), a Handheld Software Tools .dat file, a text file (.txt) or an .mdb database. The metafile may be imported into graphic programs and the text file can be imported into a spreadsheet. The .dat and .mdb files are used exclusively by Handheld Software Tools.

To save a plot as a Windows metafile, click on the **File** menu and select **Export to Metafile** from the pull down menu. Once the trace is saved as a metafile, it can be copied and transferred into other applications as a picture or graphic file.
To copy a metafile:

**Step 1.** Select the trace to be copied with the mouse cursor.

**Step 2.** Select **Edit** and then **Copy**. The file will be copied to the clipboard, or select **File** and then **Export** to a Windows metafile.

**Step 3.** Open the target application (Microsoft Word, etc.).

**Step 4.** Select **Edit** and then **Paste**. The file will be inserted as a graphic file or a bitmap.

**Saving a Plot to a Spreadsheet**

Plots can be saved as a text file (.txt) which can then be imported into a spreadsheet program.

To save a plot as a text file:

**Step 1.** Select the trace to be copied with the mouse cursor.

**Step 2.** Click on the **File** menu and select **Export to Text File for a Spreadsheet** from the pull down menu.

**Step 3.** Save the file to a local directory.

**Step 4.** Exit the Handheld Software Tools program and open the spreadsheet application.

**Step 5.** Import the .txt file into the spreadsheet program.

**Creating a Database**

A single trace or a block of traces can be transferred from the instrument to the PC. A separate database can be created for each cellular site. The site name can be used as the database name.

**Step 1.** Select the **File** menu and select the **Database**.

**Step 2.** Open an existing database or create a new database with a descriptive filename that represents the site name.

Once the database has been created, files can be saved and site information can be added, such as Plot Description, Date/Time, Operator, record/trace number and session description (transmitter type, etc.)

Individual plots will be labeled with the Database Site Name. Each record has its own plot description and measurement type.

**Printing Formats**

One to multiple plots per page can be set up under the print format in Handheld Software Tools. Orientation of how the plots are printed on the page can be changed from vertical to horizontal.
Cable List

A custom cable list can be created in Software Tools and uploaded to the Site Master. Some standard 1000 MHz, 2000 MHz, and 2500 MHz cables are stored in the Site Master and are listed in Appendix A of this User’s Guide.

The cable list contains vital information such as propagation velocity (V_p) and insertion loss (dB/m or dB/ft). These parameters are important when identifying faults and discontinuities of transmission lines.

NOTE: Values for the cable list are taken from manufacturers specifications. Complex digital communications systems may require adjustment to attenuation values at the higher frequencies. Contact the manufacturer for the appropriate cable losses.

The Cable Editor is specifically designed to provide contractors, service providers, and network operators with a list of cable types that are tailored to their use.

To open the Cable Editor, select the Tools menu and select Cable Editor.

To open an existing cable list file, select File and Open. Select the desired cable list and press Enter.

Creating a Custom Cable List

To create a custom cable list:

Step 1. Select the File menu and select New.

Step 2. Type in or cut and paste the cable types and specifications for the desired cables.

Uploading a Cable List

After custom cable list has been created in Handheld Software Tools, it can be uploaded to the Site Master. The serial communication null modem cable must be connected from the Site Master to the PC.

In the Cable Editor, select Tools and Upload Cable List. The software will confirm the upload with a message “Upload Complete” when the operation is finished.

Querying the Site Master Cable List

Query Cable List allows the user to check and review the contents of the custom cable list in the Site Master.

In the Cable Editor, select Tools and Query Cable List. The software will download the cable list from the Site Master to the PC.

DTF Plots

Handheld Software Tools can convert Return Loss in Frequency Domain (Freq-RL) plots and SWR in Frequency Domain (Freq-SWR) plots to DTF plots.
Chapter 7 Handheld Software Tools

To convert from Frequency Domain to Distance to Fault, follow these steps:

**Step 1.** Capture a plot or load a previously saved plot.

**Step 2.** Click the Distance-to-fault button on the toolbar (or choose Distance-to-Fault from the Tools menu). A dialog will open allowing you to specify the cable parameters, start distance, and stop distance. The cable type may be selected from the pull-down list. Selecting a cable from the list automatically sets the propagation velocity and insertion loss. To manually enter the dielectric constant and insertion loss, select the Custom cable type from the top of the list. Click OK when finished. A new window will open showing the converted plot.

**Step 3.** Use the cursor to read out values shown in the bottom tray of the PC screen, at each point along the DTF trace. Maximize the plot window for best cursor resolution.

**NOTES:** The distance units (meters or feet) can be changed by selecting Default Plot Settings from the Settings menu.

The stop distance entry must be less than or equal to the maximum un-aliased range (D-Max), and the start distance must be less than the stop distance.

Smith Chart

The Smith Chart is a commonly used graphical format for the analysis of the impedance of transmission lines. It can be a useful tool for fine tuning an antenna system.

Handheld Software Tools can convert the following types of plots to Smith Charts:

- Return Loss (Frequency Domain)
- VSWR (Frequency Domain)

To convert a plot to a Smith Chart:

**Step 1.** Capture a plot or load a previously saved Return Loss or VSWR plot.

**Step 2.** Click the Smith Chart button on the toolbar (or choose Convert to Smith Chart from the Tools menu). A new window will open showing the plot in Smith Chart form.

**Step 3.** To read values from a Smith Chart, move the mouse pointer over a data point. When the mouse pointer turns into a hand, click once with the left button. A pop-up window will appear with various measurement data.
Signal Standards Editor

The Signal Standards Editor is a software application for viewing, editing and creating signal standards files. Select a signal standard entry from the list to make it active.

The Signal Standards Editor can:
- Create new signal standards files
- View and edit the signal standard definitions
- Copy and paste signal standard definitions
- Retrieve the signal standards file from a test unit
- Store an updated signal standards file back onto the test unit
- Generate a report of the signal standards file

Creating a New Signal Standards File

To create a new signal standards file, select New Signal Standards File from the File drop-down menu. An empty signal standards file will be displayed. To add a signal standard, select Add Signal Standard from the Edit menu.

To add an existing signal standard from a different signal standards file, use the Cut, Copy and Paste icons, or select Cut, Copy and Paste from the Edit menu.

Editing a Signal Standard

A signal standard definition can be changed by editing the name and parameters. The active line of the current signal standard is displayed in the text entry box under the main toolbar. If this box is disabled, the selected signal standard cannot be edited.

All changes are temporary until saved as a disk file. To save the signal standards file on the local PC, select Save from the File menu.

Cut, Copy and Paste

Use the Cut, Copy and Paste icons, or select Cut, Copy and Paste from the Edit menu to add, copy or remove signal standards.

Cut moves the currently selected signal standard onto the clipboard and the signal standard is deleted from the Signal Standards list. If the signal standards file is saved, the cut signal standard will be permanently deleted from that list.

Copy puts a copy of the signal standard on the clipboard, but does not delete it from the current Signal Standards list.

Paste copies a signal standard from the clipboard into the current Signal Standards list.
Chapter 7 Handheld Software Tools

Retrieving Signal Standards Files

Connection Manager must be connected to a test unit before retrieving a Signal Standards file. An active connection is indicated in the Status Bar at the bottom right corner of the application window.

To retrieve a Signal Standards file, select Retrieve Signal Standards from the Connection menu, or use the short-cut icon on the button bar. The retrieved Signal Standards data will replace all existing Signal Standards data in the Signal Standards Editor. To store the current Signal Standards data locally, select Save from the File menu and save the current Signal Standards file before retrieving another the Signal Standards file from a test unit.

Storing Signal Standards Files

To upload the Signal Standards file to a test unit, select Upload Signal Standards from the Connection menu, or press the short-cut icon on the button bar. This will upload the current Signal Standards file to the test unit, overwriting any data already on the test unit.

Signal Standards Reports

A signal standards report is generated by selecting the Report function from the File menu. A signal standards report is an HTML file and can be opened inside the default web-browser of the PC, where it can be printed if desired.
Chapter 8
Master Software Tools

Introduction

This chapter provides an introduction to the Anritsu Master Software Tools (MST) program. Users of the legacy Handheld Software Tools (HHST) program are strongly encouraged to migrate to new MST platform. This new platform has numerous productivity advantages over HHST as described below in the list of features. All future product enhancements will be implemented via MST.

Master Software Tools is a suite of Microsoft Windows programs for transferring saved measurements, along with markers and limit lines, to a PC display. The programs provide the ability to modify display parameters, overlay multiple traces, upload and download traces, print traces using local or networked printers, create or modify language files, edit the cable and signal standard lists, and convert .dat files to the new .vna format.

Master Software Tools requires Windows 2000 (Service Pack 4 or above), Windows XP (Service Pack 2 or above), or Windows VISTA. MST will not function on earlier versions of the Microsoft Windows operating system as the program relies on the Microsoft .NET Framework.

Key Features of Master Software Tools

- DAT File Conversion Tool – this utility imports .DAT files from Handheld Software Tools and converts them to the new MST format. The .DAT file is unchanged by the process. Once converted, these new files can be opened and edited using the Measurement Editor.
- Cable Editor – This application allows you to delete, modify, and add new cables to the instrument memory.
- Signal Standard Editor – If there is a standard that is not included in the instrument, MST can modify, edit, and append the signal standard list.
- Product Update – This feature keeps you informed of the latest instrument firmware version.
- Integrated Codeloader – No need to install a separate program to upgrade instrument Firmware. Everything can be addressed with MST.
- Trace Rename Utility – Allows you to rename hundreds of traces in a couple of minutes. This is a real time saver for people spending a lot of time renaming traces.
- Group Edit – If you have a folder with hundreds of traces and you forgot to turn on the markers or limit lines, you can use the Group Edit tool to copy the markers and limit line from one trace to all traces in a specific folder.
- Advanced limit line editor – Create and upload complex limit line masks to the instrument.
- Standard Windows File Management – simplify the process of downloading, dragging, and dropping files.
Chapter 8 Handheld Software Tools

- Language Editor – this utility allows you to add new or modify existing language tables. Languages available for selection are English, French, German, Spanish, Italian, Japanese, Chinese and Korean. All of these languages except for English can be edited. Up to two more custom languages can be loaded using this utility.
- AVI Files – Create video files of your favorite Spectrogram measurement.

Figure 8-1. VNA measurement using the marker table

Figure 8-2. Trace Rename utility enables you to rename hundreds of traces in minutes
NOTE: New firmware is not compatible with Master Software Tools version 1.25 or older. Insure that you have maximum functionality by updating your Master Software Tools to the latest version.
Minimum System Requirements

- Microsoft Windows 2000 (Service Pack 4 or above), Windows XP (Service Pack 2 or above), or Windows VISTA
- Microsoft .NET Framework, Version 2.0
- Intel Pentium 233 MHz microprocessor (Pentium III 350 MHz or better recommended)
- 128 MB of available RAM (256 MB or above recommended)
- Hard disk drive with approximately 80 MB of available space (an additional 80 MB free space for storage of captured plots is recommended.)
- A USB port (USB 1.2 required, USB 2.0 recommended) or an Ethernet 10/100 Base-T connection for communication with the instrument
Appendix A
Windowing

Introduction

The FREQ/DIST menu (page 2-11) provides for setting the cable loss and relative propagation velocity of the coaxial cable. The Window key opens a menu of FFT windowing types for the DTF calculation.

The theoretical requirement for inverse FFT is for the data to extend from zero frequency to infinity. Side lobes appear around a discontinuity due to the fact that the spectrum is cut off at a finite frequency. Windowing reduces the side lobes by smoothing out the sharp transitions at the beginning and at the end of the frequency sweep. As the side lobes are reduced the main lobe widens thereby reducing the resolution.

In situations where there may be a small discontinuity close to a large one, side lobe reduction windowing should be used. When distance resolution is critical windowing can be reduced.

Examples

The types of windowing in order of increasing side lobe reduction are: rectangular, nominal side lobe, low side lobe, and minimum side lobe. Figures A-1 thru A-4 show examples of the types of windowing.

Figure A-1. Rectangular Windowing Example
Appendix A Windowing

Figure A-2. Nominal Side Lobe Windowing Example

Figure A-3. Low Side Lobe Windowing Example
Figure A-4. Minimum Side Lobe Windowing Example
# Index

## A
- accessories .......................... 1-2, 1-4

## B
- battery .................................. 2-23
- brightness .............................. 3-13

## C
- cable loss .............................. 4-2, 4-5
- calibration ............................ 1-10, 3-2
- case .................................... 3-15
- clock .................................. 2-14
- connectors ............................. 2-1
- CW ...................................... 4-3

## D
- date format ............................ 2-14 - 2-15
- DTF .................................. 2-11, 3-8, 4-2, 4-7, 7-5, 7-9
- DTF Aid ................................. 2-11, 3-8

## E
- error messages .......................... 2-19
- ESD .................................... 1-11

## F
- FFT ................................ A-1
- FlexCal ................................. 2-14, 2-22
- frequency .............................. 2-11
- frequency range ..................... 1-1

## G
- grounding .............................. 2-1

## H
- hard keys ............................... 2-5
- hold .................................. 2-7, 2-17

## I
- InstaCal .............................. 1-11, 2-21, 3-2

## K
- keys
  - hard ................................ 2-5
  - soft ................................ 2-8

## L
- language .............................. 2-14 - 2-15, 3-11
- limits ................................ 2-13, 3-12
- line sweep ............................ 4-1

## M
- maintenance .......................... 1-10
- markers ............................... 3-11, 7-6
- measurements
  - cable and antenna ................. 4-1
- memory ............................... 2-7
- metafile .............................. 7-7

## O
- offset ................................ 3-6
- OSL .................................. 2-14, 3-2

## P
- plot overlay ............................ 7-7
- power indicator ...................... 2-23
- power meter
  - high accuracy .................. 1-2, 1-8, 2-22, 6-1
- power monitor ..................... 1-2, 1-8, 2-2, 2-16, 5-1
- printers ............................ 3-14
- propagation velocity ............. 2-11
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>resolution</td>
</tr>
<tr>
<td></td>
<td>4-8</td>
</tr>
<tr>
<td></td>
<td>return loss</td>
</tr>
<tr>
<td></td>
<td>4-2, 4-9</td>
</tr>
<tr>
<td></td>
<td>RS232</td>
</tr>
<tr>
<td></td>
<td>2-2, 7-4</td>
</tr>
<tr>
<td>S</td>
<td>scale</td>
</tr>
<tr>
<td></td>
<td>3-8</td>
</tr>
<tr>
<td></td>
<td>self test</td>
</tr>
<tr>
<td></td>
<td>2-14 - 2-15, 2-18, 2-24, 3-1</td>
</tr>
<tr>
<td></td>
<td>serial interface</td>
</tr>
<tr>
<td></td>
<td>7-4</td>
</tr>
<tr>
<td></td>
<td>Smith Chart</td>
</tr>
<tr>
<td></td>
<td>1-2, 7-10</td>
</tr>
<tr>
<td></td>
<td>soft keys</td>
</tr>
<tr>
<td></td>
<td>2-8</td>
</tr>
<tr>
<td></td>
<td>Software Tools</td>
</tr>
<tr>
<td></td>
<td>7-1</td>
</tr>
<tr>
<td></td>
<td>specifications</td>
</tr>
<tr>
<td></td>
<td>1-7</td>
</tr>
<tr>
<td></td>
<td>spreadsheet</td>
</tr>
<tr>
<td></td>
<td>7-1</td>
</tr>
<tr>
<td></td>
<td>static</td>
</tr>
<tr>
<td></td>
<td>1-11</td>
</tr>
<tr>
<td></td>
<td>SWR</td>
</tr>
<tr>
<td></td>
<td>2-20, 3-8, 4-2, 4-7, 7-5</td>
</tr>
<tr>
<td></td>
<td>symbols</td>
</tr>
<tr>
<td></td>
<td>2-17</td>
</tr>
</tbody>
</table>

Index-2